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Copyright notiCe
No part of  this publication may be reproduced mechanically or electronically or in any form 
without the prior written permission of  CADlink. The software described in this manual 
is furnished under license and may only be used or copied in accordance with the terms 
of  such license. The information in this manual is for informational use only, is subject to 
change without notice and should not be construed as a commitment by CADlink. CADlink 
assumes no responsibility or liability for any errors or inaccuracies that may appear in this 
document. EngraveLab®, EngraveLab Foundation®, EngraveLab Expert®, EngraveLab 
Laser®, EngraveLab Photo Laser Plus®, and EngraveLab Pro® are registered trademarks 
of  CADlink Technology Corporation.

Written and designed at CADlink Technology Corporation

2150 Thurston Drive, Ottawa, ON, Canada, K1G 5T9

Phone (613) 247-0850

Fax (613) 247-1488

Manual & Package Design by CADlink Marketing and Customer Support.

Printed in Canada. Product of  Canada.

© May 2011, CADlink Technology Corporation
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ContaCt information
If  you have not already done so, then we ask that you perform registration of  
your package, such that CADlink Tech Support has current information that 
allows them to resolve your issues promptly. Registration includes:

 □ Software updates
 □ Special pricing on upgrades
 □ Special pricing on other CADlink products

Internet

www.cadlink.com

www.engravelab.com

e-maIl

sales@cadlink.com

UnIted StateS

500 Main Street

Clinton, MA 01510

Tel: 1-800-545-9581

Fax: (613) 247-1488

Canada

2150 Thurston Drive

Ottawa, ON K1G 5T9

Tel: (613) 247-0850

Fax: (613) 247-1488

eUrope

Intech House, Wilbury Way

Hitchin, Herts, U.K. SG4 0TW

Tel: ++44(0) 1462-420222

Fax: ++44(0) 1462-420111

Germany

Georg Christoph Neller Str. 3

D-54296 Trier

Tel.: +49 (651) 96644840

Fax.: +49 (651) 96644841
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WelCome to engravelab
EngraveLab is Computer Aided Design (CAD) software for laser and rotary engraving 
systems. EngraveLab provides leading edge technologies as an all-in-one package that 
designers can adapt to run their production shops efficiently. EngraveLab includes tools 
that support a wide variety of  applications, and development is ongoing to provide you with 
support for the latest technologies.

EngraveLab provides simple, versatile tools that include designing with text, line art, and 
images (i.e., bitmaps). EngraveLab also provides significant support for other design 
applications, so that unfinished or archived designs can be brought into EngraveLab for pre-
production work.

Note: The available EngraveLab features will vary according to the type of  EngraveLab 
package that has been purchased.
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neW feature highlights
The following sections provide a brief  overview of  new EngraveLab 
features.

 □ Import/Export Files
 □ Transparency (Opacity) Support
 □ Image and Color Support
 □ Power Tools
 □ General Feature Improvements
 □ Text Compose
 □ Rotary Engraving Tools
 □ Laser Engraving Tools
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Import/Export FIlEs

	□ Import	and	Export	Filters - Ongoing improvement of  import and export 
filters.

	□ Stored	Tool	and	Path	Information	- Now with every job, the tool and 
pathing information are stored within the CDL file.

	□ Transparency	Support - For imported design files that contain an alpha 
channel (i.e., a transparency layer), EngraveLab preserves the transparency.

	□ Publish	PDF	with	Color	Matching - When publishing your design as a 
PDF proof, you can now specify whether the PDF is for on-screen display, 
or for a printed proof. This will ensure that the customer sees the expected 
design colors.

transparEncy (opacIty) support

	□ Transparency	Gradient	Fills - These fills create gradient effects that allow 
the underlying objects to “show through” (Fig. 1).

	□ Improved	Fluid	Mask	Support - With the introduction of  transparency 
support in EngraveLab, this enables you to make full use of  the Fluid 
Mask Blend tool when working with difficult foreground subjects, like hair. 
Resulting images can be positioned with new backgrounds, and the hair 
regions will blend naturally (Fig. 2).

Note: Fluid Mask is an optional add-in that might already be included with your package.

ImagE and color support

	□ CMYK	Color	Management - Expanded on-screen color management 
now includes the display of  imported CMYK images, which avoids the 
potential for color shifts between RGB and CMYK color spaces.

	□ CMYK	Color	Mode - Likewise, images created within EngraveLab can 
be set as CMYK color mode, which expands upon the previous RGB, 
Grayscale, Indexed Color and Monochrome modes.

	□ Optimized	Memory	Handling - Though not an explicit feature, the 
underlying code within EngraveLab has been significantly optimized with 
respect to previous versions, such that manipulation of  large images should 
be noticeably improved.

	□ New	Plug-ins - The collection of  EngraveLab plug-ins have been 
expanded with more CADlink and third-party plug-ins.
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Fig. 2 - On the right is a stock photo of a feather against a black 
background. On the left, FluidMask has knocked out the black background, 
and the resulting image has been placed above a yellow oval shape. Notice 
how the Blend tool works in conjunction with transparency in EngraveLab 
to retain the ruffled details of the feather (particularly at the bottom left).

Fig. 1 - After using PhotoLaser to prepare the image for laser engraving, a 
radial transparency fill was then applied.
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powEr tools

	□ Easy	Menu	Board	Creation - As part of  the new Text Compose interface, 
interactive tools have been introduced for constructing menu boards, which 
can also be used to align trophy entries with ease (Fig. 3).

	□ Spiral	Shape	Tool - In addition to the existing collection of  basic shape 
tools, spiral shapes can now be created. Like other parametric objects, on-
screen handles can be used to customize the spiral appearance.

	□ Total	Area	Calculation	Tool - For costing material usage, select one-or-
more objects that represent the physical area that will be engraved (e.g., 
trophy plate), and then perform the area calculation.

	□ Realistic	Engraving	Blanks - As opposed to a simple rectangular plate 
size, set a custom blank that has unusual shapes or contours, such as 
trophies or atypical door plates (Fig. 3).

gEnEral FEaturE ImprovEmEnts

	□ Dotted	Line	for	Strokes - Create dashed (and dotted) lines that have a 
specific dash length and space between dashes (Fig. 4).

	□ Adding	Plates	to	Badged	Jobs - Badges can now be created in the form 
of  Plate Objects, which include the convenience of  adding additional plates 
to make use of  otherwise waste material.

	□ Lasso	Select - As opposed to making selections with a rectangular 
selection marquee, you can freehand draw an irregular region that will select 
all of  the enclosed objects (Fig. 5).

	□ Optimized	Cut	Path,	Vectorization	and	Centerline - The underlying 
algorithms for generating cut paths,  vectorization and centerline trace have 
been optimized, such that previously large jobs can now be completed in a 
fraction of  the time.

	□ Job	Notes	Lookup - A new search feature has been introduced for 
browsing and inspecting customer information and job history.

	□ Multiple	Stroke	Colors - As opposed to having a solid stroke color, 
strokes can be composed of  a blend between two distinct colors (Fig. 6).

	□ Thickness	in	Free	Edit	Mode - When using the Free Edit node editing 
brush, a line thickness can now be automatically applied.

	□ Default	Fill	and	Stroke	Colors - Defaults can now be defined 
independently for shapes, text and notes.



21New Feature Highlights

Fig. 3 - The Menu Board feature provides easy layout for an award 
with assorted name columns. In addition, the plate size has been set to 
a custom blank shape.

Fig. 4 - Both dash and gap length can be applied as part of a line style.
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tExt composE

	□ Expert	Text	Compose	Mode - The SmartBar controls have been grouped 
into four convenient modes: Line, Character, Frame and Table.

	□ Text	Underline - An underline can now be created for text, which is 
treated as a separate object for manipulation. In addition, the underline can 
optionally ignore space between words.

	□ Character	Picker - For unusual characters that are difficult to reproduce 
with a standard keyboard arrangement, use the character picker in Text 
Compose mode to display and select a desired character.

	□ Default	Text	Settings - Whereas text compose would remember the 
previously used text attributes, default settings can instead be configured.

	□ In-place	Text	Justification - The option now exists text to remain in place 
when changing the left/center/right justification.

	□ Individual	letter	colors - The color of  individual characters can now be 
set independently within a given paragraph.

	□ Text	Undo/Redo	- Within text compose there are undo/redo controls for 
reversing previous text operations.

	□ Custom	Word	Spacing	- The spacing between words can now be 
compressed/expanded in terms of  either a percentage or absolute width.

	□ Flexible	X/Y	Coordinates - In text compose, the x/y coordinates can be 
set for either individual lines, and/or the paragraph as a whole.

	□ Custom	Character	Widths	- Compress or expand individual characters, 
either in terms of  a percentage or absolute width.

	□ Single	Line	Font	Conversion	- Create single line fonts from either 
TrueType or Adobe PFB fonts. Editing is easy and results can be saved.

rotary EngravIng tools

	□ New	Lead	In	Modes	- For tooling operations that require a lead in, there 
are two additional modes: Ramp and Online.

	□ Long	plate	feature	- For jobs that exceed the machine limits, two-or-more 
component jobs can be performed that are each part of  the main job.

lasEr EngravIng tools

	□ KnockMeColorOut	plug-in - Remove background colors from images 
with ease.
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Fig. 5 - When using the Lasso Select tool, press [Shift] when adding 
to current selection. Press [Ctrl] to select objects partially within the 
lasso.

Fig. 6 - The stroke on this text is a blend 
between two colors. Both stepped and 
linear effects are also possible.
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	□ Wood	Effect	plug-in - Using vector shapes as a basis, create the 
appearance of  realistic wood surfaces.

	□ Sketched	Effect	plug-in - Convert an image into a hand sketched artwork.
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QuiCk start and setup proCedures

CheCklist
Use the following as a quick checklist when setting up EngraveLab. These steps 
are elaborated upon in the following pages of  this guide.
1. Install EngraveLab from the CD
2. During installation, indicate the driver that is required for each machine
3. After installation, connect the EngraveLab security dongle
4. If  not already done, then connect the machine that will be receiving the cutting data. 

For proper installation of  cutting knives, drill bits and loaded material, please consult 
the Operator Manual for the machine. When using the machine for the first time, it is 
recommended that a sample piece of  material be loaded.

5. Launch EngraveLab

For rotary EngravErs

Rotary engravers use the Engrave menu commands for setup and output.
1. Within EngraveLab, configure the driver settings for the machine (Output dialog 

and Engraving	Defaults dialog). In particular, indicate the output port to which the 
machine is connected, and confirm that the Machine	Limits are correct.

2. Create shapes on workspace and apply tool paths to these shapes. To minimize wasted 
material when using the machine for the first time, it is recommended that small shapes 
be used.

3. Enter the Engrave Preview state. This is done by choosing the Output command under 
the Engrave menu.

4. In the Engrave Preview state, confirm that the shapes are placed correctly.
5. At the far-right of  the Output	Manager toolbar, click the Engrave button. 

EngraveLab will now send the cutting data, and the machine should now be receiving 
the data.

For lasEr EngravErs

Laser engravers use a printer driver that was included from the manufacturer. 
Please install the printer driver before continuing.
1. Within EngraveLab, load engraving colors into Shop Palette.
2. Create shapes on workspace and apply fill and stroke colors. Fill colors represent 

engrave fills, and stroke colors represent cut lines.
3. From the Print dialog, configure your printer by clicking Setup on the Printer tab.
4. On the Print dialog, click OK to send the job to the laser engraver. 
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installing engravelab
EngraveLab is provided with an orange USB security dongle to prevent unauthorized use or 
pirating of  the software. This dongle is a flash drive that plugs into a standard USB port of  
the computer, and it is transparent to other applications. Only EngraveLab is aware of  the 
device.

Note: Before installing, please verify that you have administrative permissions. Otherwise, 
Windows will prevent the installation of  the dongle support software.

polIcy on lost or stolEn sEcurIty dEvIcEs

 □ The USB security device provided with EngraveLab is your proof  of  purchase. If  the 
dongle is lost or stolen, then that is equivalent to losing the entire software package, and 
a new package of  EngraveLab must be purchased.

 □ In the event of  a damaged security device that must be replaced, there is a nominal fee 
for EXCHANGING a new device for the older device, where the older device must be 
reclaimed by CADlink.
This fee is waived where product is still under warranty.

 □ Regardless, it is recommended that you ensure that your security device is covered 
under your business insurance policy.

Temporary License Files
 □ License files are included with your USB dongle, which are used to confirm the features 

within your CADlink products.
 □ If  a replacement dongle is being shipped to you, then you will typically be issued 

“temporary” license files that will enable you to continue using your CADlink products.
 □ Temporary license files will cease working after a set criteria, though the expectation is 

that your replacement dongle will arrive prior to expiry.
 □ Please note that the replacement dongle will be provided with new “permanent” license 

files that will replace the temporary license files.

Storing Your License Files
 □ In the event of  lost license files, there is a nominal administrative fee for issuing 

replacement license files.
The fee is waived if the Free Support period is still active. Otherwise, replacement 
license file issues are treated like Tech Support requests.

Connect your orange dongle 
BEFORE installing your 
EngraveLab software!
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 □ When CADlink sends you new license files, it is important that you create backups of  
the license files, so they can be easily located when re-installing your CADlink products 
on new equipment.

 □ In the case of  the orange USB flash drive dongle, your license files can be stored on the 
dongle itself. When re-installing your CADlink products, license files upon the dongle 
will be automatically used.

program InstallatIon

1. Connect the USB security device NOW.
2. Insert the EngraveLab install CD into your CD-ROM drive. The install 

wizard should “auto start”.
If  the install wizard fails to auto start, then you will need to start the 
installation process manually:

 □ From the Start menu, choose Run to open the Run dialog.
 □ Click Browse and locate the setup.exe file that is on the CD in the CD-

ROM drive.
 □ Click Open to choose the setup.exe file, and click OK to close the Run 

dialog.

3. During the installation, you will be asked to install various components:
 □ If  you are asked to insert a license disk or CD, then insert the license 

disk or CD that was provided with your EngraveLab package. Verify 
that the drive path is correct, and click OK to continue.

 □ When asked to install cutter drivers, it is recommended that you install 
drivers for your cutters at this time. You will be provided with a list of  
manufacturers and cutters to choose from.

 □ When asked to install fonts, it is recommended that you install fonts at 
this time. The installer will locate any TrueType fonts that are already 
installed and make them available for use in EngraveLab.

4. After the installation is complete, restart Windows.
5. If  you were asked to insert a license disk or CD during the install, then eject 

the disk and store it in your EngraveLab package.
6. Launch EngraveLab from the Start menu >> All	Programs >> 

EngraveLab group.
7. Proceed to the Customizing the EngraveLab Workspace chapter.
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Customizing the engravelab WorkspaCe
The following are common elements of  the EngraveLab workspace that you 
may wish to customize.
Once the workspace is ready, proceed to either 1) Preparing a Rotary Engraving Job, 
or 2) Preparing a Laser Engraving Job.

common vIEw mEnu controls

Note the following View menu controls that toggle elements of  the 
EngraveLab workspace:
	□ Show	Plate	– Toggle the plate size, which is used to preview the cuttable 

area of  the loaded media.
	□ Show	Fill	– Toggle the object fill colors.
	□ Show	Bitmap	Outlines	– Toggle the display of  imported or linked images.
	□ Show	Tool	Diameter	– Show the thickness of  the tools being used for 

cutting tool paths.
	□ Show	Tool	Paths	– Toggle the display of  tool paths.

InstantrEplay

Under the Options menu, confirm that the Use	InstantReplay item is checked 
(ON).
InstantReplay tracks the history of  operations and special effects that have 
been applied to objects. When InstantReplay is ON, changes to an object will 
automatically update any operations or special effects that have been applied to 
that object.
When creating badges that have variable text, InstantReplay will re-apply 
operations and special effects for the text of  each badge.
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multIplE InstancE

To have more than one EngraveLab window open at the same time, enable the 
Multiple	Instance option under the Options menu. To help manage these 
windows, there will be two additional commands under the File menu: Close 
and Close	All.
	□ Close	– Close the current EngraveLab window (prompt to save)
	□ Close	All	– Close all of  the EngraveLab windows

Having extra EngraveLab windows allows components of  the design to be 
edited separately and then combined. To move a selected object between 
EngraveLab windows, use the Copy and Paste commands. In addition, objects 
can be drag-and-dropped between EngraveLab windows.

workspacE rulErs

The workspace rulers can be set for either millimeters or inches. The units of  
measurement can be changed using either of  the following:

 □ Left-click the ruler and choose either Inches or Millimeters from the 
context menu (Fig. 7).

 □ From the Options menu, choose EngraveLab	Setup >> General	
Preferences, and then specify the Units.

Fig. 7 - Left-click the EngraveLab ruler to change 
the units of measurement.
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platE sIzE

The plate size is a guide that indicates the available cutting space. You will need 
to set the plate size according to the material that is loaded in the machine. The 
plate size is also used for placement of  badges and plate objects.

 □ The visibility of  the plate size is toggled via View menu >> Show	Plate.
 □ Change the plate size via Layout menu >> Plate	Size (Fig. 8).

On the Plate	Size dialog, set the following:
 □ Set Current	Selection to Custom.
 □ Set Orientation to either Portrait or Landscape.
 □ Set Origin	Selection according to where the grid origin should be 

positioned.
 □ Set the Width and Height (the units here will correspond to the ruler 

settings).

Fig. 8 - Use the Plate Size dialog to configure the 
on-screen preview of the cutting area.
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importing from CoreldraW or adobe illustrator
EngraveLab supports a wide range of  commonly used file formats, such that 
you can work in the design environment that is most comfortable for you. 
The resulting design can then be brought into EngraveLab for further output 
preparation. The following sections provide advice about how to use some of  
the more common file formats. Though CorelDraw and Adobe Illustrator are 
mentioned, the advice is typical of  how to use these file formats with other 
design applications.

crEatE a dEsIgn In EngravElab

If  you do not already have a design for importing, the design can be created in 
EngraveLab.
For designs that will be used to create multiple badges, creating a plate design 
within EngraveLab provides greater control for customizing the text frame 
properties to automatically adjust text size and kerning for each badge. This is 
described in the Create a Plate Design in EngraveLab chapter.

Import a dEsIgn From corEldraw

Choose from the following methods to bring a design from CorelDraw to 
EngraveLab. To preserve font information, avoid converting text to graphics 
when importing or exporting.
A) From the CorelDraw Standard menu, click the Send	to	EngraveLab 

button. You will be prompted to choose the data format that will be sent to 
EngraveLab.

B) From the CorelDraw File menu, choose Save	As and save the design as 
an AI file. When saving, do not use a file compatibility greater than Adobe 
Illustrator 8.0 .

C) From the CorelDraw File menu, choose Export and save the design as an 
EPS file. Check that text is being exported as text.

D) From the CorelDraw File menu, choose Publish	to	PDF. Note that the 
PDF publish settings can be used to embed font information within the 
PDF file.
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Import a dEsIgn From adobE Illustrator

Use the following method to bring a design from Illustrator to EngraveLab. To 
preserve font information, avoid converting text to graphics when importing or 
exporting.

 □ From the Adobe Illustrator File menu, choose Save	As.
 □ When saving an AI or PDF file, set the subset fonts at 1% to embed font 

information within the file.

preparing a rotary engraving Job
The following procedure describes how to configure EngraveLab for a 
rotary engraving job. We will begin by adjusting the machine settings within 
EngraveLab, creating a design that has a tool path for engraving, previewing 
how that design will appear before output, and then sending the job to be cut.

Note: For laser engravers, please refer to the subsequent procedure, Preparing a Laser 
Engraving Job.

machInE sEtup

When EngraveLab is installed for the first time, or when drivers for a new 
machine have been installed, the Output dialog should be used to configure 
EngraveLab for output to the machine.
1. From the Windows Start menu, launch EngraveLab.
2. The Plate	Size dialog will query for the size of  your engraving bed. 

Typically, the Width and Height are set according to the cutting area of  
your machine.
These settings can be modified later using Layout menu >> Plate Size.

3. From the Engrave menu, choose Engraving	Defaults. The Output	
dialog will open (Fig. 9).

4. Verify that the Selected	Driver	and Tool	settings are correct.
Where shapes will be cut with more than one pass (i.e., cutting to progressive 
depths), the Tool setting should be “Multiple Pass” or “Router” (depending 
on the machine model). Make sure Plate is selected.

5. The Output	Tool	Paths checkbox will probably be enabled by default. 
If  so, then clear the checkbox. If  this checkbox is already cleared, then 
proceed to the next step.
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6. With the Output	Tool	Paths checkbox clear, click the option to tick it. The 
Tool	Path	Options dialog will open (Fig. 10).

Fig. 9 - Use the Output dialog to set default parameters for your 
machine.

Fig. 10 - The Tool Path Options dialog is 
used to enable the creation of tool paths, or 
to automatically apply a default tool path 
to objects.
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7. Click the Output	Tool	Paths option. Enabling this option indicates that 
the tool paths will be previewed in the Engrave	Preview state.

8. Clear the “Also	Cut	Contour	Paths” option. If  this option were checked, 
then all objects (aside from tool paths) will be viewed as contour cutting 
paths in the Engrave Preview state. By disabling this option, only tool paths 
will be previewed in the Engrave	Preview state.

9. Click OK to close the Tool	Path	Options dialog. The view will return to 
the Output dialog.

10. Click Save	Default to confirm your changes.
11. Click the Setup button (Fig. 11).

12. The Engraver	Setup dialog will open.
13. On the Engraver	tab, confirm that the Machine	Limits	have not been 

exceeded (Fig. 12).
14. Click the Port tab (Fig. 13).
15. Set the Method = Direct to port.
16. Set the Port	Location for the machine.

In the vast majority of cases with CNC routers, the port will be “FILE:”, and the 
router will have a system for downloading the output file that is generated by 
EngraveLab. For more information, please refer to the Operator Manual that 
was provided with the router.

17. Click the Engraver	Options	tab (Fig. 14).

Fig. 11 - From the Output dialog, click Setup to 
open the Engraver Setup dialog.
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Fig. 12 - Confirm the Machine Limits.

Fig. 13 - On the Port tab, specify the Port Location for which the 
machine is connected.
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18. Set the Origin	and End	Point	according to where you want the machine to 
start and finish each job.

19. Click OK	to close the Plotter	Setup	dialog.
20. Click OK	to close the Output	dialog.

crEatIng a tool path

At this point, EngraveLab has been configured to send output to your machine. 
Now we want to create a design and assign a tool path that can be output for 
cutting.
1. On the EngraveLab workspace, create a rectangle shape.
2. With the rectangle shape selected, left-click the Online button from the 

Tool	Path	Tools flyout (Fig. 15).
3. The Online dialog will open (Fig. 16).
4. Some of  the key information of  a cut template is the Tool being used and 

the Depth being cut. The color will be used for displaying the tool path on 
the workspace.

Fig. 14 - On the Engraver Options tab, specify the Origin (starting 
tool position) and the End Point (ending tool position).
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5. Click OK to apply the tool path and close the Online dialog.
6. The resulting tool path will appear like a stroke on the rectangle. If  the 

tool path is not visible, then confirm that the Show	Tool	Paths	option is 
enabled (View menu).

Note: In step (2), left-clicking the Online	button forced the Online	dialog to open, whereas 
right-clicking would have applied the most recently used Online	tool path (if  any).

Fig. 15 - Select the shape and choose Online from the Tool Path 
Tools flyout.

Fig. 16 - Set the tool and cutting depth.
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prEvIEwIng and cuttIng thE tool path

1. Now that the tool path has been created, choose Engrave menu >> 
Output to activate Engrave	Preview mode. The tool path will be 
positioned as it would be cut upon the material (Fig. 17).

2. Within the Engrave Preview mode, the device limits are shown as a green 
rectangle, so that the placement of  the tool path can be confirmed. In 
the SmartBar, verify that both the Device and Tool are the same as were 
selected previously within the Output dialog.

3. At this point, the cut data is ready to be sent from EngraveLab. Please 
confirm that the machine is online and loaded with the appropriate material.

4. On the Cut	Manager	toolbar, clicking the Engrave	button will begin the 
sending of  cut data.

Note: If  the Port	Location	of  the Plotter	Setup	dialog had been set to “FILE:”, then 
EngraveLab will prompt for a filename and file location before saving the cut data.

Fig. 17 - In Engrave Preview mode, the device limits are shown as a 
green rectangle.
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preparing a laser engraving Job
Whereas cutting to a rotary engraver uses the Engrave menu >> Output 
command for sending a job, laser engravers use the File menu >> Print 
command because the printer driver is used to interpret the image data for laser 
engraving. In this manner, laser engravers can interpret object fills and strokes 
as cut data. 
1. From the Windows Start menu, launch EngraveLab.
2. The Plate	Size dialog will query for the size of  your engraving bed. 

Typically, the Width and Height should be set according to the cutting area 
of  your machine.

3. These settings can be modified later using Layout menu >> Plate Size.

sEt a dEFault color palEttE

1. From the Options menu, choose Palette >> Load >> Set	Default.
This command is also available through the Shop Palette context menu.

2. The Default	Palette browse dialog will open.
3. From the EngraveLab install directory, browse to the Palettes >> Engrave 

directory.
4. In the Engrave directory are an assortment of  color palettes per different 

manufacture of  laser engraver. Each palette contains colors used by the 
given manufacturer to indicate speed and power.

5. Choose the color palette that corresponds to your laser engraver, and then 
click the Save button.

6. From the File menu, start a new workspace by choosing New.
7. Along the bottom of  the workspace, note that the Shop Palette has loaded 

the manufacturer palette that you had previously set as the default.
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sEttIng FIll and strokE colors

With laser engravers, object fill colors produce an engrave fill, and hairline 
colors produce a cutting line.
1. Under the View menu, confirm that there is a checkmark beside the Show	

Fill option.
2. Under the View menu, confirm that there is a checkmark beside the Show	

Tool	Paths option.
3. Create a circle shape and assign a black fill.

(i.e., select the circle and left-click black in the Shop Palette)

4. Draw a square shape around the circle and assign an Invisible fill to the 
square (Fig. 18).
(i.e., select the square and left-click Invisible in the Shop Palette)

5. Select the square shape.
6. From the Stroke	and	Fill	Tools flyout, choose Tool	Diameter.
7. In the SmartBar, choose a Hairline style, and set a red stroke color.

Fig. 18 - Set an invisible fill by left-clicking Invisible on the Shop 
Palette.
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prIntIng to thE lasEr EngravEr

As mentioned previously, laser engraving output is driven through a printer 
driver, so output from EngraveLab in done using the File menu >> Print 
command.
1. From the File menu, choose Print. The Print dialog will open.
2. On the Printer tab, select your laser engraver.

Note: If  your laser engraver is not listed, then refer to the installation instructions provided 
with your laser engraver.

3. Tick the Preview checkbox (Fig. 19).
4. Click the Preferences	tab (Fig. 20).

Fig. 19 - The Printer tab is used 
to select the laser engraver and 
adjust its output properties.

Fig. 20 - The Preferences tab is used to choose what 
workspace elements should be output.
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5. Tick the Print	As	Shown	On	Screen	checkbox.
6. Click the Plate	Area	option.
7. If  required, tick the Print	by	Colors	option.

The Print	by	Colors	option is used to maintain a particular sequence in 
which the objects are cut.

8. On the Printer tab, click the Setup button.
9. The Properties dialog for your laser engraver will open.
10. The controls on the Properties dialog will vary according to your model of  

laser engraver.
For specific instructions concerning these controls, please refer to the 
documentation provided with your laser engraver.

11. The following aspects of  the Properties dialog (e.g., Fig. 21) should be 
confirmed:

 □ For the colors defined within the driver, adjust the power and 
speed settings as required.

 □ For each color, set the pen mode to output both raster and vector 
data.

 □ Confirm that the engraving area is correct.
 □ Set the cutting mode to Black	and	White.

12. Click OK	to accept the Print	dialog settings and enter the Print	Preview	
page.

sEndIng thE lasEr EngravIng Job

1. The file is ready to be sent from EngraveLab.
2. Confirm that the machine is online and loaded with the appropriate 

material.
3. In Print	Preview, click Print	to begin engraving (Fig. 22).
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Fig. 21 - The Properties dialog will vary according to the model of 
laser engraver. To learn more about the available controls, check 
the help instructions that were included with the printer driver 
installation.

Fig. 22 - In Print Preview, click the Print button to send output to 
the laser engraver.
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traCing artWork into Cut paths
See	also: Prepare to Vectorize Wizard

Often a customer will provide sample artwork or business cards that are of  
relatively poor quality for engraving. In such a case, use the AccuScan image 
editing features to clean up and trace the artwork into vector paths that can be 
cut.

ImportIng a bItmap ImagE

Your EngraveLab installation directory contains a Tutorial sub-directory. Within 
the Tutorial directory are sample files that can be used with the following 
procedure.
1. From the File menu, choose the Import item. The Import File dialog will 

open.
2. Browse to the Tutorial directory and choose the cortech.tif  file.
3. Click Import to proceed.
4. Click on the workspace to place the imported file (Fig. 23).

convErt thE ImagE to monochromE

In order to obtain the best tracing results, convert the image to monochrome.
1. Select the image.
2. Choose Image	menu >> Mode	>> Monochrome (Fig. 24).
3. The image will now be in monochrome format.

Fig. 23 - An imported image 
on the workspace.

Fig. 24 - From the Image menu, the Mode 
flyout is used to change the type of image.
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tracIng thE ImagE wIth accuscan

The monochrome image is now ready to be traced by AccuScan.
1. With the image selected, choose AccuScan from the Scan	Tools flyout 

(Fig. 25).
2. The AccuScan controls will become available within the SmartBar.
3. At the far-right of  the SmartBar, the controls for Vectorization, Trace	

Setup, and Saved	Settings are available (Fig. 26).

Fig. 25 - Select the image and choose AccuScan. Alternatively, double-
clicking an image will activate AccuScan.

Fig. 26 - In AccuScan mode, the tracing tools will become 
available in the SmartBar.
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4. From the Save	Settings drop-list, choose the “Small Serif  Text” item 
(Fig. 27).

5. To begin tracing the image, click the Vectorization button. Our sample 
image is relatively simple, so only a moment will be required to complete 
the tracing.

6. Once the image trace is complete, click the Close button to close AccuScan 
and return to the Select state. The trace is now grouped on the workspace.

7. Drag the bitmap aside, so that you can see the traced line art.
8. To see the tracings more clearly, toggle the View menu >> Show	Fill 

command.

Fig. 27 - Several presets for tracing are available from the 
drop-list.
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adding Cut paths to line art
Under the Engrave menu, the Contour Cut tool is used to create cut paths. This 
section discusses how to add cut paths to line art, and the subsequent section 
will discuss images.

1. Select the imported line art that you want to add contour cut paths to.
2. From the Engrave menu, choose Contour	Cut. 
3. At the far-left of  the SmartBar, select the type of  contour cut path that you 

want to create.
4. Tick Inside/Outside to cut both inner and outer contours. Otherwise, 

only the outer contours will be cut.
5. Set the Corner	Style according to how rounded or sharp the cut paths 

should be (Fig. 28).

6. Set the Offset	according to how you want the cut lines spaced along the 
line art contours (Fig. 29).
The Offset amount indicates the distance between the object contour and 
the resulting contour cut. An Offset of zero will place the cut lines precisely 
along the edges of the line art, whereas a positive or negative value may be 
set according to how much trimming you want.

Fig. 28 - Use the Corner Style to adjust how the cut path 
follows the shape contour.
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7. If  you selected the Miter	corner style, then the Miter	Limit	field will 
appear.
The Miter Limit is applied between the corners of the original object and 
the contour cut. This limit is expressed as a percentage of the Offset amount 
(Fig. 30).

8. The Color	Picker is used to indicate the color of  the dashed contour cut 
lines on the workspace.
For rotary engravers, choose a color that allows you to differentiate the 
contour cut lines within the design. If you later use the Filter By Color tool, 
then you can choose which contour cut paths to cut according to their color.

For laser engravers, choose a color according to the power and speed settings 
within the printer driver.

9. Click an empty portion of  the workspace to finish editing the contour cut 
paths.

10. The contour cut paths will appear as dashed lines along the contour of  the 
line art.

Fig. 29 - The Offset is the distance of the cut path from the 
object contour.

Fig. 30 - The Miter Limit is the 
percentage of corners that are trimmed.
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adding Cut paths to images
From the Engrave	menu, the Contour	Cut	command is used to create cut 
paths for images in three ways:
A. Create a rectangular cut line around the bounding area of  the image.
B. Create an irregular cut line that traces the transition between white and dark 

portions of  the image.
C. Create an irregular cut line that traces the transition along a specific 

grayscale value in the image.

1. Select the imported image that you want to add contour cut paths to. 
2. From the Engrave menu, choose Contour	Cut (Fig. 32).
3. At the far-left of  the SmartBar are two checkboxes: Inside/Outside and 

Bitmap	Frame. These checkboxes control how cut lines are created for an 
image. For example:

 □ To cut within the rectangular bounds of  the image, the Bitmap	
Frame	checkbox should be OFF	(no tick).

 □ To create a cut lines that follow the contour of  the image (i.e., inner 
contours), the Inside/Outside	checkbox should be ON	(ticked).

Fig. 31 - From left to right are three examples of cut lines having 
been added to an image. In the first image, the cut lines follow 
the rectangular bounds of the image. In the second image, the 
cut lines follow the contour of the image. In the third image, the 
cut lines include a shadow that has been added to the image.

Fig. 32 - The SmartBar displays the Contour Cut controls.
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4. Set the Corner	Style according to how rounded or sharp the cut paths 
should be.

5. Set the Offset according to how you want the cut lines spaced along the 
image contours.

6. Select a color from the Color	Picker to use for the dashed contour cut 
lines on the workspace.

 □ For rotary engravers, choose a color that allows you to differentiate 
the contour cut lines within the design. If  you later use the Filter	
By	Color tool, then you can choose which contour cut paths to cut 
according to their color.

 □ For laser engravers, choose a color according to the power and 
speed settings within the printer driver.

7. Click Apply to create contour cut paths for the image. If  the Bitmap	
Frame checkbox = OFF, then the Monochrome	Filter dialog will open 
(Fig. 33). Otherwise, proceed to step (8).

Fig. 33 - The Monochrome Filter dialog is used to force 
near-white hues to white, or near-black shades to black. 
This is typically done to obtain a clean cut line that closely 
follows the image contour.
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 □ To trace the contour of  an image that has a white background, set 
the Threshold to 255 (move the slider all the way to the right).

 □ To trace the contour of  an image that has a shadow effect, set the 
Threshold somewhere around 200 (move the slider close to the 
right).

 □ For a monochrome image, the slider will not be adjustable.

8. Click within an empty portion of  the workspace to finish editing the 
contour cut paths.

tIps whEn sEttIng thE thrEshold valuE

The Threshold value on the Monochrome	Filter	dialog determines the 
contour cut between the light and dark portions of  the image. Behind the 
scenes, EngraveLab is analyzing a monochrome (i.e. black-and-white) version 
of  the image to determine the discrete boundaries of  the image. To improve the 
process, consider the following:

 □ The image is composed of  a fine grid of  pixels. Each pixel in the image 
has a brightness that ranges from 0 to 255. A brightness that is close to 0 is 
considered to be near white (maximum lightness), whereas a brightness that 
is close to 255 is considered to be near black (maximum darkness).

 □ For each pixel in your image, a brightness lower than the Threshold will 
be considered to be white, and a brightness above the Threshold will be 
considered to be black.
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Create a plate design in engravelab
Use the following procedure to create a single plate design with text that adjusts 
to the plate margins.
1. Under the Options menu, verify that Guides >> Use	Guides is ON 

(i.e., has a checkmark).
2. Create a rectangular shape that will represent the dimensions of  the plate.
3. With the rectangle selected, press [Shift] and then right-click the upper-left 

handle of  the rectangle.
4. Two guides will be created.
5. Press [Shift] again and right-click the lower-right handle.
6. Another two guides will be created.

Note: To distinguish between the rectangle and text, either toggle the View	menu >> Show	
Fill	option, or assign different fill colors to each object.

7. From the Text	Tools flyout, choose Text	Compose.
8. Using the guides, click and drag a text frame from the upper-left to the 

lower-right of  the rectangle.
9. The text controls will appear in the SmartBar (Fig. 34).

Fig. 34 - When composing text, the Text Tool controls will appear in the 
SmartBar. All text objects have a text frame, for which margins, justification, etc. 
can be customized. The Toolbar Mode is used to choose the available controls.
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16. Click the “Compress	text	only	when	height	exceeded” option.
17. From the Method drop-list, choose “Character height compression”.
18. Click OK to close the Vertical	Compression	dialog.

crEatE tExt In thE tExt FramE

Now that the text frame margins and compression have been set, we can 
enter several lines of  text. As new lines are added, text compression will be 
automatically applied. This text compression will also be applied when creating 
badges that have variable text.
1. When the Vertical	Compression	dialog was closed, the view returns to the 

text frame.
2. Type a line of  text and press [Enter].
3. Type a second line of  text and press [Enter].
4. Type a third line.
5. As each line is added, note how the character heights are automatically 

reduced to fit the text within the text frame.
6. Click in an empty portion of  the workspace to finish editing.

10. Click the Center	Justify button.
11. For the Line	Layout, click Centered.
12. For the Toolbar	Mode, choose Frame to reveal the margin fields.
13. Click the Fixed	Width and Fixed	Height buttons, such that the margin 

fields are editable.
14. Set the margins to Percent	Margins, and set each margin to a 6.0 value.
15. Click the Vertical	Compression button (Fig. 35) to open the Vertical	

Compression dialog.

Fig. 35 - Adjusting the margins and compression settings for a text field.
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preparing a series of single plate badges
Use the following procedure to prepare a series of  badges, where only one 
badge will be cut at a time. Text substitution can be applied for each badge, such 
that the InstantReplay feature will automatically replicate any special effects that 
have been applied to the text, such as outlines, transformations, or shadows.

Note: If  a plate design needs to be created, then refer to the Create a Plate Design in 
EngraveLab chapter.

Note: If  a plate design needs to be imported from another design application, then refer to 
the Importing from CorelDraw or Adobe Illustrator chapter.

posItIon thE InItIal dEsIgn

Position the design on the plate according to where the machine should cut 
(Fig. 36)

applyIng an onlInE tool path For rotary EngravErs

1. For laser engravers, proceed to Applying Colors for Laser Engravers.
2. We want to apply an online tool path, which InstantReplay will replicate 

for each badge.
3. Select the text shape, and then create an Online tool path from the 

Engrave menu (Fig. 37).

Fig. 36 - Position the design on the sign plate as it 
will be output. Each badge will be automatically 
arranged at this position.
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4. The Online	dialog will open. For this example, a 0.005 ¼” Engraver was 
used, and the Depth	was set to 0.01” (Fig. 38).

5. Click OK	to accept the Online	dialog settings, and the tool path will be 
applied.

6. Note that the View	menu >> Show	Tool	Diameter	command can be used 
to toggle visibility of  the tool paths.

Fig. 37 - Under the Engrave menu, tool paths are 
created from the Create Tool Path flyout. These 
tool paths can also be created from the Tool Path 
Tools flyout.

Fig. 38 - Choose the loaded tool and indicate the cutting depth. 
The Color will be used when displaying the tool path on the 
workspace.
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applyIng colors For lasEr EngravErs

1. For rotary engravers, proceed to the Initial Badge Setup.
2. Check that the fill and stroke colors are correct for the plate design.
3. The colors set here will be replicated for each badge.

InItIal badgE sEtup

1. Select all the elements of  your plate design. The objects selected will be 
replicated for each badge.

2. From the Layout menu, choose the Badges item. The Badge	Setup dialog 
will open (Fig. 39).

Fig. 39 - Use the Badge Setup dialog to set margins, spacing, and 
variable text for each badge.
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3. Tick the Use	Plate checkbox to limit each badge to a single plate.
4. If  the Use	Plate checkbox is already ticked, then clear the checkbox and 

then tick it again. The Page	preview will now show as a single, white 
badge, as opposed to multiple badges arranged on a single plate.

5. Notice that the Plate fields, Height and Width, have been set to the 
dimensions of  the sign plate. These settings are fine. 

6. Set the Margins according to your design. This is unnecessary if  you have 
already defined margins within the text field.

7. Set the Spacing – Vertical and Horizontal to zero.
8. If  present, clear the Compress	Equally	Over	Copies option (OFF).

sEt varIablE tExt

1. For our example, we have a tab-delimited text file that contains country 
names and the name of  their representative

2. In the Replaceable	items	/	text	list, click each item for which text 
replacement should be applied. For this example, only the first two text 
fields have been selected (Fig. 40).
The [Ctrl] and [Shift] modifier keys can be used when selecting from this list. 
Note that these items are listed according to the order in which they were 
created on the workspace.

3. Within the Replacement	data	file	section, click the Browse	button and 
choose the text file that contains your replacement text.

4. This example uses the “MemberStates.txt” file that is in the EngraveLab 
Tutorial directory (Fig. 41).

Fig. 40 - Select text fields for text 
substitution.

Fig. 41 - Choose a text file that 
contains replacement text.
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5. When the text file is loaded, note that the number of  badges is updated to 
reflect the number of  data entries found within the file.

6. To the right of  the Browse	button, verify that the drop-list indicates the 
delimiter that is used in the text file. In this example, “Tab” indicates that 
the fields within the text file are separated by [Tab] characters.

tExt substItutIon For Each badgE

1. At the bottom-right corner of  the Badge	Setup dialog, click the OK 
button.

2. The Text	Substitution dialog will open (Fig. 42).
3. All of  the entries from the text file will now be listed.

Along the bottom of the Text Substitution dialog, note the shortcuts that 
can be used to rearrange the columns.

4. Click OK to accept the Text	Substitution fields, and EngraveLab will 
proceed to create the badges. 

thE FInIshEd badgEs 
1. When the badges have been completed, the workspace will display the first 

badge in the series (Fig. 43).
2. Recalculating such operations is part of  the InstantReplay functionality 

that is built into EngraveLab. 

Fig. 42 - Data is read and summarized in the Text 
Substitution dialog.
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 □ For rotary engraving jobs, notice that the Online	tool	path 
operation has been recalculated to account for the substituted text.

 □ For laser engraving jobs, note that the fill and stroke color 
assignments have been retained for each substituted text object.

   
3. To view the remaining badges, use the Paging	Tool that is at the bottom-

right corner of  the workspace. Click the Forward and Back navigation 
buttons to access the other badges (Fig. 44).

Fig. 43 - After badges have been created, the view will return to the 
EngraveLab workspace, where text substitution for each badge has 
occurred.

Fig. 44 - Use the Paging Tool to browse each badge.
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Creating multiple badges per plate
Use the following procedure to prepare a series of  badges, where multiple 
badges will be arranged on each single plate. Text substitution can be applied 
for each badge, such that the InstantReplay feature will automatically 
replicate any special effects that have been applied to the text, such as outlines, 
transformations, or shadows.

Note: If  a plate design needs to be created, then refer to the Create a Plate Design in 
EngraveLab chapter.

Note: If  a plate design needs to be imported from another design application, then refer to 
the Importing from CorelDraw or Adobe Illustrator chapter.

Note: In the lesson, Creating a Multi-line Plate, the multi-line plate was stored as a 
“badge . cdl” file, and badge replacement text was stored as a “MemberStates.txt” file. Both 
files will be referred to within this lesson.

posItIon thE InItIal dEsIgn

When creating multiple badges per plate, the initial placement does not matter 
because the badges will be automatically positioned on the plate size (Fig. 45).

Fig. 45 - When creating multiple badges per plate, 
the initial position does not matter because the 
badges will be arranged automatically.
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applyIng an onlInE tool path For rotary EngravErs

1. For laser engravers, proceed to Applying Colors for Laser Engravers.
2. We want to apply an online tool path, which InstantReplay will replicate 

for each badge.
3. Select the text shape, and then create an Online tool path from the 

Engrave menu (Fig. 46).
4. The Online dialog will open. For this example, a 0.005 ¼” Engraver was 

used, and the Depth was set to 0.01” (Fig. 47).
5. Click OK	to accept the Online	dialog settings, and the tool path will be 

applied.
6. Note that the View	menu >> Show	Tool	Diameter	command can be used 

to toggle visibility of  the tool paths.

Fig. 46 - Under the Engrave menu, tool paths are 
created from the Create Tool Path flyout. These 
tool paths can also be created from the Tool Path 
Tools flyout.
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applyIng colors For lasEr EngravErs

1. For rotary engravers, skip to the Initial Badge Setup.
2. Check that the fill and stroke colors are correct for the plate design.
3. The colors set here will be replicated for each badge.

InItIal badgE sEtup

1. Select all the elements of  your plate design. The objects selected will be 
replicated for each badge.

2. From the Layout	menu, choose the Badges	item. The Badge	Setup	dialog 
will open (Fig. 48).

3. Clear the Use	Plate checkbox, such that multiple badges can fit within a 
single plate.

4. Note that the Page	Preview shows multiple badges arranged on a single 
plate.

5. Notice that the Plate fields, Height and Width, have been set to the 
dimensions of  the sign plate. These settings are fine. 

6. Set the Margins according to your design. This is unnecessary if  you have 
already defined margins within the text field.

7. If  present, clear the Compress	Equally	Over	Copies option (OFF).
8. Set the Spacing – Vertical and Horizontal to zero.
9. Verify that the Compress	Text	Equally	Over	Copies option is disabled.
10. Choose Score	Lines from the drop-list (next to Use	Plate).

Fig. 47 - Choose the loaded tool and indicate the cutting depth. 
The Color will be used when displaying the tool path on the 
workspace.
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11. Use the color picker to choose an appropriate score line color. For laser 
engravers, this color should represent a speed and intensity that will allow 
the badges to break cleanly.

sEt varIablE tExt

1. For our example, we have a tab-delimited text file that contains country 
names and the name of  their representative

2. In the Replaceable	items	/	text	list, click each item for which text 
replacement should be applied. For this example, only the first two text 
fields have been selected (Fig. 49).
The [Ctrl] and [Shift] modifier keys can be used when selecting from this list. 
Note that these items are listed according to the order in which they were 
created on the workspace.

Fig. 48 - Use the Badge Setup dialog to set margins, 
spacing, and variable text for each badge.
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3. Within the Replacement	data	file	section, click the Browse	button and 
choose the text file that contains your replacement text.

4. This example uses the “MemberStates.txt” file that is in the EngraveLab 
Tutorial directory (Fig. 50).

5. When the text file is loaded, note that the number of  badges is updated to 
reflect the number of  data entries found within the file.

6. To the right of  the Browse	button, verify that the drop-list indicates the 
delimiter that is used in the text file. In this example, “Tab” indicates that 
the fields within the text file are separated by [Tab] characters.

tExt substItutIon For Each badgE

1. At the bottom-right corner of  the Badge	Setup dialog, click the OK 
button.

2. The Text	Substitution dialog will open (Fig. 51).
3. All of  the entries from the text file will now be listed.

Along the bottom of the Text Substitution dialog, note the shortcuts that 
can be used to rearrange the columns.

4. Click OK	to accept the Text	Substitution	fields, and EngraveLab will 
proceed to create the badges. 

thE FInIshEd badgEs

1. When the badges have been completed, the workspace will display the first 
page of  badges (Fig. 52).

Fig. 49 - Select text fields for text 
substitution.

Fig. 50 - Choose a text file that 
contains replacement text.
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2. If  there are more badges than will fit on a single plate, the Paging	Tool	
can be used to view the remaining badges. Click the Forward and Back	
navigation buttons to access the other badges (Fig. 53).

Fig. 51 - Data is read and summarized in the Text 
Substitution dialog.

Fig. 52 - After badges have been created, the view 
will return to the EngraveLab workspace, where text 
substitution for each badge has occurred.

Fig. 53 - If there are additional plates of 
badges, then use the Paging Tool to browse 
each plate.
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photo laser – preparing an image for laser engraving
The Photo Laser tool is used to prepare an image for output through a laser 
engraver. Various image filters are available for improving the quality of  the 
image, and you can choose from preset settings that have been configured for 
different types of  material. Since a laser engraver is essentially a monochrome 
device (laser on or laser off), any color information retained in the image is not 
useful, so the resulting photo laser image will be in monochrome format.
1. Import an image onto the EngraveLab workspace (Fig. 54).
2. From the Transform	menu, choose Photo	Laser	>> Interactive.
3. The Photo	Laser	dialog will preview the effect of  applying the various 

filters (Fig. 55).
4. In the Filter	list, right-click will toggle a filter between ON/OFF.

Fig. 54 - Import either a full color, grayscale, or 
monochrome image. Photo Laser will perform the 
necessary conversion to produce a monochrome image 
that is laser-ready.
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usIng prEsEt FIltEr sEttIngs

In the lower-left corner of  the Photo Laser dialog, click the Load	Presets	
button to choose from an assortment of  parameter files that have been 
configured for various materials (Fig. 56).

suggEstIons For adJustIng FIltErs From scratch

If  you wish to adjust the Photo Laser settings without using preset values, then 
it is recommended that you start with only one filter, and then incrementally 
increase the number of  filters until you achieve the desired results. For example:

 □ Right-click to turn OFF all the filters, except for the Histogram	filter.
 □ Adjust the Histogram	filter to trim excess shadow (Black) and excess 

highlight (White).

Fig. 55 - In the On/Off column, right-click to toggle each filter.
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 □ If  necessary, adjust the midtone (Gamma) to obtain more balance in the 
resulting shades.

 □ At this point, the image can be further refined by incrementally turning on 
more filters, one by one, and making adjustments as appropriate.

 □ For example, turn ON an Edge	filter, set it to Unsharp	Mask, and then 
adjust the Amount, Radius	and Threshold	to find values that produce 
good results.

 □ Then turn ON	the Threshold	filter and adjust the Threshold	slider to 
help sharpen the image.

output thE photo lasEr Job

1. From the Photo	Laser dialog, click OK to apply the filter settings.
If  Keep	Original = ON, then the resulting image will be placed beside the 
original.
If  Keep	Original = OFF, then the preview image will be placed beside 
the resulting image. As a proof, the preview image can be shown to the 
customer (Fig. 57).

2. From the File menu, choose Print to open the Print dialog.
Note: See the Preparing a Laser Engraving Job chapter for more details about File	menu >> 
Print.

Fig. 56  - Choose from Photo Laser presets for an assortment of 
material types.
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3. Click OK	to accept the Print	dialog settings and enter the Print	Preview	
page.

4. Confirm that the machine is online and loaded with the appropriate 
material.

5. In Print	Preview, click Print	to begin engraving.

Fig. 57 - For the resulting image, use File >> Print to output the Laser Engraving job.
The preview image simulates how the job will appear on the given material, which can be 
shown to customers as a proof.
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Chapter 1

the engravelab WorkspaCe

In This Section…
 □ Workspace customization
 □ Locations of  menus, color palettes and toolbars
 □ Methods of  creating shapes and text
 □ Selecting shapes and basic layout controls
 □ Setting fill and stroke colors
 □ Creating gradient fills and color blends

The center of  the EngraveLab environment is the workspace, which includes grid lines, 
horizontal and vertical rulers, and a rectangular outline to represent the plate size.

The plate	size dimensions are usually set equal to the material that is being machined, such 
that the placement of  art and text can be visualized. However, for some design work it may 
be more convenient to hide the plate size.

QuiCk Customization tips
Depending on the other software packages that you are familiar with, you may have certain 
preferences for how the workspace is set up. The following are some of  the EngraveLab 
workspace settings that may be of  immediate use to you:

	□ Options menu >> EngraveLab	Setup >> General	Preferences – Set the units of  
measurement, as well as the grid size

	□ View menu >> Show	Plate – This is used to turn on the rectangular area that helps 
you visualize the size of  the material that you are working on

	□ View menu >> Show	Fill – This is used to show the fill color of  line art shapes. Turn 
this off  to see only the wireframe view of  shapes

	□ View menu >> Show	Bitmap	Outlines – This is used to show only a wireframe 
rectangle of  bitmap shapes

	□ View menu >> Link	Show	Fill	and	Bitmap	Outlines – When Show Fill is toggled, 
also causes wire frames to be shown instead of  bitmap image.

	□ View menu >> Show	Tool	Diameter – Illustrate the widths that tool paths require
	□ View menu >> Show	Grid – This is used to display the grid lines
	□ Options menu >> Grid – This is where objects can be set to snap to the grid lines
	□ Options menu >> Guides – This is where guidelines can be created or removed
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menu, smartbar, and toolbars
Above the workspace is the menu bar, the SmartBar, and one-or-more toolbars.

The menu	bar is typical of  most Windows applications.

The SmartBar is a special, dynamic toolbar that displays controls that are specific to the 
current operation that is being edited.

The other toolbars are customizable. Buttons may be added or removed from these 
toolbars. New toolbars may also be created.

Color palettes
Below the workspace are the color palettes.

The Shop	Palette	is the main color palette that displays colors that are available for use as 
either fill or stroke colors.

The Sheet	Layer	Palette	provides the ability to arrange shapes on separate layers. Each 
layer can represent a different type of  media (black vinyl, white vinyl, etc.).

tools toolbar
To the left of  the workspace, the Tools toolbar contains the main shape creation and 
manipulation tools. For most of  the Tools buttons, clicking will open additional toolbars.

Job palette
To the right of  the workspace, the Job	Palette	lists the process colors, foil colors, primers, 
and halftones that are currently in use on the workspace.

In addition to listing colors, the Job	Palette can be used to perform global search-and-
replace of  colors, primers, halftones, etc.

sEt all rEd shapEs to a bluE FIll color
1. Suppose that you have several red shapes
2. In the Job Palette, click the ellipsis button and choose Color	View from the context 

menu
3. Note that the red color appears in the Job Palette
4. From the Shop Palette, drag a blue color plate and drop it onto the red Job Palette color
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rEplacE all shadEs oF a spot color
1. Suppose that you have five shapes with different tints of  a gold spot color, say 100%, 

80%, 60%, 40%, and 20% tint
2. In the Job Palette, click the ellipsis button and choose Foil	View from the context 

menu
3. Note that the Job Palette lists the different shades of  gold as a single color plate
4. From the Shop Palette, drag a green spot color and drop it onto the gold Job Palette 

color

shape Creation
From the Tools toolbar, the Shape	Tools (Fig. 58) are used to create circles, rectangles, 
polygons, stars, arrows, and fan shapes. These shapes are sometimes referred to as 
“parametric shapes” because they have extra editing handles for adjusting the shape 
parameters, such as number of  sides, notched corners, rounding, etc.

From the Tools toolbar, the Graphic	Edit	Tools (Fig. 59) are used to edit scanned or 
imported vector artwork. Often, scanned artwork has extra nodes and rough edges that need 
to be “cleaned up” using these node editing tools. In addition, the Graphic	Edit	Tools can 
be used to draw freehand shapes and trace simple artwork.

Fig. 58 - Basic shapes that are available from the 
Shape Tools flyout.

Fig. 59 - Node editing is available 
from the Graphics Edit Tools 
flyout.
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Removing excess nodes when node editing
1. From the Shape	Tools flyout, create an oval shape.
2. Select the oval and choose Arrange	menu	>>	Convert	to	Polygon.
3. Double-click the oval to begin node editing.
4. Drag a marquee to select all of  the nodes.
5. Press the ‘ u ’ key to select only alternate nodes.
6. Press the [DEL] key.

From the Tools toolbar, the Ginsu	Knife	Tools (Fig. 60) are used to subdivide selected 
shapes. The Open	path tool will leave the subdivided objects as open paths, whereas the 
Close	path tool will create closed paths.

When a Ginsu	Knife tool is chosen, click on the workspace to place one-or-more cutting 
nodes that intersect the selection. Then click Apply to subdivide the selection.

text Creation
From the Text	Tools flyout (Fig. 61), the Text	Compose tool is used to create text shapes. 
When creating text, the text frame determines the bounds of  the text.

Methods of setting the text frame:
	□ Click	on	workspace: This will set an entry point for the text. As text is typed, the text 

frame will expand and contract to enclose the text.
	□ Click	along	a	shape	contour: Hold the cursor over the edge of  a shape, such that the 

cursor turns black. Click and type text to fit text to the shape contour.
	□ Click	and	drag	marquee: Dragging a marquee with the mouse will set the text 

frame bounds. As text is typed, the text frame will remain fixed, and the text will be 

Fig. 60 - Subdivide shapes using the 
Ginsu Knife Tools flyout.

Fig. 61 - Text Compose is available from the 
Text Tools flyout.
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constrained according to the text frame properties.
	□ Press	[Shift]	and	click	on	workspace: This will set the text frame equal in size to the 

plate size. 
	□ Frame	Text	Compose	button: This button will set the text frame equal to the plate 

size.

The Spell	Check tool will check the spelling for all text shapes.

The Text	Underline tool will create underlined text. Right click to set the underline 
properties.

From the Transform menu, the Fit	Text	to	Arc command is used to fit the text to a circular 
contour.

From the Transform menu, the Fit	Text	to	Path command is used to fit the text shape to 
the contour of  another shape.

From the Weld Tools flyout (Fig. 62), the Basic	Weld is used to bond script lettering, such 
that there is no overlap between adjacent characters.

However, keep in mind that the result of  the weld will no longer be a text shape, so make 
sure that the text is correct before doing the weld.

Fig. 62 - For script lettering, kern the lettering 
and then use the Basic Weld tool.
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seleCting shapes
Left-click a shape to select it. The [Shift] key can be used to add/remove shapes with 
respect to the current selection.

To select multiple shapes, click-and-drag the cursor to form a marquee. All shapes that 
are within the marquee will be selected. Alternatively, use the Lasso	Selection tool 
[Shift	+	Ctrl	+	a] to draw an irregular shaped marquee. All shapes that are within the 
marquee will be selected.

If  the [Ctrl] key is pressed when dragging a marquee, then all shapes that are overlapped by 
the marquee will be selected.

By default, a shape can be selected by clicking within its filled region. Alternatively, press the 
[ALT] key to only allow a shape to be selected by clicking along its contour. This is useful 
when you are attempting to select from among several clustered shapes. For example, when 
node editing a shape that overlaps other shapes, press the [ALT] key to prevent accidentally 
choosing a different shape.

EngraveLab can be set to select shapes only when they are clicked along their contours. 
From the Options	menu, choose EngraveLab	Setup	>>	Selection	Tool	Settings. If  the 
“Use	Filled	Region	to	Select” option is unchecked, then shapes can only be selected by 
clicking along their contours.

The Job	Palette may be used to select shapes according to their color.

sElEct all shapEs oF a spEcIFIc color or tInt
1. In the Job Palette, click the ellipsis button and choose Color	View from the context 

menu.
2. Press [Shift] and then left-click a color in the Job Palette.
3. All shapes of  that color will be selected.

sElEct all shapEs oF a spEcIFIc spot color
1. In the Job Palette, click the ellipsis button and choose Foil	View from the context 

menu.
2. Press [Shift] and then left-click a color in the Job Palette.
3. All shapes of  that spot color will be selected, including tints of  that color.

properties of shapes
When a shape is selected, nine editing nubs appear about the shape. These nubs are used 
to move, resize, scale, flip, and rotate the shape. The SmartBar displays the position, size, 
rotation, color information, and type of  the shape.

Of  the nine editing nubs, the SmartBar indicates the Current	Nub	with a red highlight, and 
the SmartBar x and y values represent the position of  the Current Nub. When the SmartBar 
is used to resize a shape, the shape will be resized with respect to the Current Nub.
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From the View	menu, the Show	InstantReplay	item will activate the InstantReplay window, 
which is used to list the changes (properties and operations) that have been applied to a 
shape. Double-clicking will edit the property or operation without changing the order in 
which it was applied. Pressing the [Delete] key will reverse changes to a selected property, 
and it will remove a selected operation.

Using the cursor keys, a shape is moved (“Nudged”) one pixel at a time. Holding [Shift] will 
move the shape by five pixels.

When rotating a shape, press [Ctrl] to constrain rotation to the Snap	Angle, which is set on 
the General	Preferences	dialog.

When dragging a shape, press [Ctrl] to constrain the move horizontally or vertically. In 
addition, pressing [ALT] will create a duplicate of  the moved shape.

From the Layout menu, the Size/Move commands are also used to modify the shape 
properties, as follows:

layout mEnu sIzE/movE commands
	□ Size: Set width and height of  shape, or set scaling amount.
	□ Move: Place shape at an absolute position, or move the shape by a relative amount.
	□ Slant: Slope or skew the shape either horizontally or vertically.
	□ Rotate: Rotation can be with respect to a specific point on the workspace.
	□ Mirror: Flip the shape either horizontally or vertically.
	□ Flip: Similar to mirror, except that the line of  reflection can be adjusted.
	□ Clear	Size/Move: Remove all Size, Move, Slant, Rotate, Mirror, or Flip operations that 

have been applied to the shape.

adding fills and strokes
The Shop Palette contains the colors that can be applied to shapes as fill or stroke colors. In 
addition, the Job Palette will list all colors that are currently being used on the workspace.

For a selected shape, left-clicking a Shop Palette color will change the fill color, and right-
clicking will change the stroke color. The Shop Palette also has a Line/Fill	button, which is 
used to alternate this behavior.

When there is no selection, the SmartBar indicates the default fill and stroke colors that are 
applied to new shapes. Within the Shop Palette, a white hairline is drawn about the default 
fill color.

A newly created shape has no stroke, so its stroke color is not initially visible. From the 
Stroke	and	Fill	Tools flyout, the Line	Style tool is used to add a stroke.

At the far-left of  the Shop Palette is the Invisible Color. All other colors have a letter 
designation (P, SF, or SC) to indicate their type.
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typEs oF colors
	□ Invisible	Color: Indicates the absence of  color. For example, when a shape fill is 

Invisible, only its thick line attributes (i.e., its stroke) are available for printing or cutting.
	□ Process	(P): Use the Process option when process colors are being used (i.e., where 

CMYK colorants are combined to produce a given color).
	□ Spot	Foil	(SF): Used to represent colors that will be printed with foil cartridges (i.e., 

pure colorants are applied, rather than by combining proportions of  CMYK). Shades 
of  spot foils are created by adjusting the Tint values (less than 100%), or by applying a 
gradient.

	□ Spot	Color	(SC): Defined in terms of  the LAB color space, and used to represent 
distinct color planes when printing color separations.

gradIEnts and pattErn FIlls
From the Stroke	and	Fill	Tools flyout (Fig. 63), the Gradient	Fill	tool is used to create a 
process color gradient. When printed, this fill will be rendered using CMYK colorants.

From the Stroke	and	Fill	Tools flyout, the Pattern	Fill	tool is used to tile a bitmap pattern 
on the shape.

From the Stroke	and	Fill	Tools flyout, the Transparency	Fill tool behaves like the 
gradient fill tool, except that object opacity is adjusted instead of  color.

Fig. 63 - Apply gradient fills and patterns from 
the Stroke and Fill Tools flyout.
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blEnds usIng mEtamorphosIs
From the Transform	menu, one of  the functions of  the Metamorphosis	tool is to create 
a smooth gradient blend between two line art shapes. Depending on the metamorphosis 
setting, either new colors can be created, or existing Shop Palette colors will be used.

	□ Target	layer: Use the currently selected Shop Palette color
	□ Match	layers: Locate and use only colors that are currently in the Shop Palette
	□ New	layers: Create and add new colors to Shop Palette

Metamorphosis creates the effect of  a gradient blend by creating a large number of  
intermediate shapes. For example:

Create a metamorphosis color blend
1. Create some blue text with 1” height.
2. Create a red duplicate of  the text with 5” height.
3. Select both text shapes and choose Metamorphosis from the Transform	menu.
4. Set the Mode	to New	Layers, such that new color plates will be created.
5. Set a high Count	value, such as 64.
6. Click OK, and the resulting series of  line art shapes will create the effect of  a gradient.

To create a blend that fades to “no color,” then assign the Invisible	Color to one of  the 
shape fills.
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Chapter 2

shape manipulation

In This Section…
 □ Arranging collections of  shapes
 □ Applying special effects to shapes
 □ Clipping intersecting shapes
 □ Dissecting shapes with the Ginsu Knife
 □ Converting text shapes into line art

There are many tools available that allow you to modify or combine shapes.

From the Arrange	menu, the Order	To	Front	and Order	To	Back	commands are used to 
control the display order in how shapes appear above each other. Similarly, shapes can be 
moved Forward and Backward in the display order.

From the Layout	menu, the Group	command is used to bind shapes into collections, which 
allows the shapes to be moved as a single unit. The Ungroup	command is used to release 
the collection. 

Double-clicking a group of  shapes will open the Group	Viewer, which lists the shapes 
that are part of  that group. Selecting a shape within the Group	Viewer will display all the 
attributes and operations that have been applied to that shape.

Ways to use the Group Viewer
1. Double-click an attribute for one of  the shapes within the group. Changes to that 

attribute will only apply to that shape without changing the group.
2. Drag a color from the Shop Palette, and drop it onto the “Layer” attribute within the 

Group	Viewer. The fill color of  the shape will be changed.
3. Select a shape that is not part of  the group, and use InstantReplay (see InstantReplay) 

to look at the operations that have been applied to that shape. Drag an operation from 
the InstantReplay	window, and drop it into the list of  operations displayed within 
the Group	Viewer. The operation will be automatically re-applied to the shape that is 
selected within the Group	Viewer.

From the Tools	toolbar, the Weld	Tools	are used to fuse shapes together into a combined 
shape. Alternatively, the weld tools can clip overlapping shapes. In either case, the weld tools 
actually create new shapes.
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From the Arrange	menu, the Clipping	command is used to clip overlapping shapes to the 
top-most shape. This is similar to a weld, except that the original shapes are not destroyed, 
and the Clipping	Clear	command can be used to reverse the effect.

From the Tools	toolbar, the Ginsu	Knife	Tools are used to subdivide shapes. The 
subdivided shapes can either become closed contours, or they can be left as open paths.

From the Arrange	menu, the Text	to	Graphics	command is used to convert text shapes 
into line art. This is usually done in order to combine the text shapes with other line art.

outlines and inlines
From the Transform	menu, the Outline	command is used to add the effect of  contour 
lines either around a shape (Outline), or within the shape contour (Inline). The Create	
Mask	option will weld the resulting outlines and/or inlines into a single shape.

From the Transform	menu, the Contour	Object	command is similar to the Outline	
command. A positive Offset	will create an outline, whereas a negative Offset	will create an 
inline. Overlapping portions of  the contour object will be automatically welded into a single 
shape.

Miter Limit
When applying an outline, the Miter	Limit	is a distance that is expressed as a percentage of  
the outline or inline thickness. For a sharp corner of  the original shape, the resulting outline 
corner may be quite steep. If  the Clipped	button is enabled, then the outline corner will be 
clipped as per the Miter	Limit. Only corners that are less than or equal to 90 degrees will be 
clipped.

Fig. 64 - Two star shapes with outlines. The 
second star has an outline that has been 
clipped at 70%.
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transformation
From the Transform	menu, the Transformation	command is used to apply special effects 
and distortions to shapes and/or images. Each transform comes with two versions: Vertical 
and Horizontal (Fig. 65).

Note: The following three transformations are not available when editing images: 
Perspective	Curve	Vertical, and neither of  the Fit	to	Circle transforms.

metamorphosis
From the Transform	menu, the Metamorphosis	command is used to blend two shapes 
together, and multiple intervening shapes with distinct gradients can be created.

Fig. 65 - There are six categories of Transformation commands available, 
all but three of which can also be applied to images.



84 EngraveLab 9 User Guide

shadoW
From the Transform menu, the Shadow command is used to add background shapes that 
create the appearance of  shadows (Fig. 66).

	□ Block	Shadow:	The Block Shadow is used to give shapes the perception of  depth.
	□ Perspective	Shadow:	The Perspective Shadow is used to give shapes the perception of  

distance.
	□ Drop	Shadow:	The Drop Shadow is similar to the Block Shadow, though the perceived 

space between the original shapes and their shadows is not filled.
	□ Cast	Shadow:	The Cast Shadow is used to create the perception of  a light source, such 

that the shapes project a shadow as if  onto a nearby surface.

At the far-right of  the Shadow SmartBar, the Outline checkbox (Fig. 67) is used to increase 
the thickness of  the shadow effect. When creating a shadow outline, the following outline 
options may be used:

	□ Point:	Corners of  the shadow outline are sharp
	□ Miter:	Corners of  shadow outline are clipped (See Fig. 64 for the Miter Limit 

description under Outlines and Inlines for an example)
	□ Round:	Corners of  the shadow outline are rounded and smooth
	□ Relief 	Shadow: Create a gap (equal to the Thickness setting) between the shape and  

the shadow outline

Fig. 66 - The available Shadow styles are (a) Block 
Shadow, (b) Perspective Shadow, (c) Drop Shadow, and 
(d) Cast Shadow.

(a) (b)

(c) (d)
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deCorative border
The Decorative	Border	tool is used to create a border shape that encloses either the plate 
size or selected shapes. The Decorative	Border	tool (Fig. 68) is available from both the 
Shape	Tools	flyout, and the Layout	menu.

The Clip	Art	Viewer	is also used to choose from a collection of  preset decorative borders. 
Dozens of  borders are available from the clip art sign blanks directory.

round Corners
From the Transform menu, the Round	Corner tool is used to create rounded corners for 
either inside or outside contours of  vector shapes.

Most of  the parametric shape tools include extra controls for rounding corners. However, 
the Round	Corner	tool is useful for scanned or imported vector shapes that would 
otherwise require node editing to create the rounded corners.

Fig. 67 - As an option, tick the Outline 
checkbox and increase the shadow thickness.

Fig. 68 - Decorative Border styles 
available from the SmartBar.
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stenCils
From the Shape	Tools flyout, the Stencil	tool (Fig. 69) is used to create the appearance of  
work that has been designed using a stencil pattern. Other shapes will be visible beneath the 
stencil shape.

A common stencil technique is to duplicate the shape, apply a different fill color, and then 
apply a stencil to the duplicate.

crEatIng a strIpEd stEncIl pattErn
1. Create a shape and apply a red fill color.
2. From the Options	menu, choose EngraveLab	Setup	>> General	Preferences.
3. In the General	Preferences	dialog, the Duplicates	section has X	Offset	and Y	Offset	

settings. Set both these fields to zero.
4. Click OK to close the General	Preference dialog.
5. Select the shape and choose Edit menu >> Duplicate (or use the [Ctrl	+	D] 

shortcut).
6. The duplicate has now been created precisely above the original. However, the duplicate 

is now the current selection.
7. With the duplicate still selected, apply a blue fill color.
8. From the Shape	Tools flyout, apply a Stencil effect to the duplicate.
9. After the Stencil has been applied, the original shape will show through from below the 

duplicate.

Fig. 69 - Stencil styles available from the 
SmartBar.
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Chapter 3

layout tools

In This Section…
 □ Creating guides for aligning design elements
 □ Aligning shapes to the grid, plate size, or other shapes
 □ Resetting the grid lines and ruler origin
 □ Creating arrays and sequences of  shapes
 □ Nesting shapes to minimize wasted media
 □ Automated badge and name plate creation
 □ Serializing text data for badges

guidelines
When dragging shapes, guidelines are used for precise alignment. A shape will “snap” to the 
location when dragged near a guideline.

Opening the Edit Guides Dialog
 □ When there is no selection, right-clicking on the workspace will open the Edit	Guides 

dialog.
 □ Under the Options menu, choosing Guides >> Edit	Guides will open the Edit	
Guides dialog.

 □ Double-click a guide for editing within the Edit	Guides dialog.

Creating a Guide
 □ Use the Edit	Guides dialog.
 □ Right-clicking a ruler will create a guide.
 □ For a selected shape, press [Shift] and right-click the shape nubs to create guides (not 

when editing a parametric shape).
 □ To add guides when node editing, press [Shift] and right-click the node.

Moving, Locking, and Hiding Guides
 □ When dragging a guide, press [Shift] to constrain the guide to the nearest ruler 

increments.
 □ To lock guides in place, right-click the workspace to open the Edit	Guides dialog and 

check Lock	Guides.
 □ To temporarily hide the guides, choose Options menu >> Guides >> Use	Guides. 

The default shortcut to toggle guides On/Off  is [Alt	+	W].
 □ To remove a guide, press [Shift] and right-click the guide (when there are no objects 

selected).
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Guide Labels
 □ To edit font labels, open the Edit	Guides dialog, click either the horizontal or vertical 

guide button, then click the Label	Font button.

the grid and align palette 
Press the [Control] key and right-click the workspace to display the Align	Palette, which is 
used to align shapes with respect to the grid. Typically, these tools are applied to shape nubs, 
though they may also be used when node editing.

	□ Set	Origin:	Set the grid origin to the selected location.
	□ Resize	Grid:	Resize the grid increments based on the distance between the selected 

location and the grid origin.
	□ Snap	to	Grid	Intersection:	Move the shape, such that the nub is at the nearest grid 

intersection.
	□ Snap	Vertically:	Move the shape, such that the nub is at the nearest horizontal grid 

line.
	□ Snap	Horizontally:	Move the shape, such that the nub is at the nearest vertical grid 

line.
From the Options	menu, the Reset	Origin	command will set the grid size according 
to the General	Preferences	setting. This is useful when the Set	Origin	or Resize	Grid	
commands have been used.

alignment hot keys
The following a commonly used hot keys for aligning shapes. More hot keys are listed in 
Appendix A.

alIgn sElEctEd shapEs QuIckly

[ALT + 1] Align shapes along left edge of  
bounds

[ALT + 2] Center shapes vertically

[ALT + 3] Align shapes along right	edge 
of  bounds

[ALT + 4] Align shapes along top edge of  
bounds

[ALT + 5] Center shapes horizontally

[ALT + 6] Align shapes along bottom 
edge of  bounds

[ALT + 7] Center shapes both 
horizontally	and	vertically
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alIgn shapEs to thE platE sIzE

[ALT + Insert] Align with top edge of  plate size

[ALT + Home] Center vertically along width of  plate 
size

[ALT + Page Up] Align with bottom of  plate size

[ALT + Delete] Align with left edge of  plate size

[ALT + End] Center horizontally along height of  
plate size

[ALT + Page Down] Align with right edge of  plate size

alIgn shapEs to last sElEctEd obJEct

[L] Left – Align with the left edge of  the last 
object.

[R] Right – Align with the right edge of  the last 
object.

[T] Top – Align with the top edge of  the last 
object.

[B] Bottom – Align with the bottom edge of  the 
last object.

[E] Horizontally – Center horizontally along 
height of  last object.

[C] Vertically – Center vertically along width of  
last object.
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alignment tool
From the Layout menu, choose Arrange	and	Distribute	>> Alignment. The Alignment	
controls will appear in the SmartBar (Fig. 70).

Note: The Align command will reapply whatever settings were last used with the 
Alignment tool.

	□ Align	to	plate	size: Shapes are aligned relative to the plate size
	□ Align	to	grid: Shapes are aligned relative the grid lines
	□ Align	to	last	object: For several selected shapes, align the shapes according to the last 

shape selected in the group
	□ Align	to	selected: For several selected shapes, align the shapes according to the 

bounding box that is around the selection

When aligning text shapes, the following options are also available from the 
SmartBar (Fig. 71):

	□ Treat	Text	Line	as	an	Object: Enabled when using equal vertical spacing. For a 
text paragraph that has multiple lines, this option will cause each line to be aligned 
separately.

	□ Ignore	Descenders: Enabled when using equal horizontal spacing. Causes the text 
descenders to be ignored, such as for letters ‘j’, ‘p’, and ‘q’. Alignment is performed with 
respect to the text baseline.

Fig. 70 - Alignment options available from the SmartBar.
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array
From the Layout	menu, the Array	command is used to arrange multiple copies into rows, 
columns, or arcs.

For shapes arranged on an arc, specify the arc radius and the range of  angles over which the 
copies are spread.

When creating an array, the copies can be automatically rotated. The Spin	Each	option will 
rotate each subsequent copy by the Spin	Amount. The Total	Spin	option will progressively 
rotate each copy, such that the final copy is rotated by the Spin	Amount.

start seQuenCe
From the Layout menu, the Start Sequence commands are available from the Sequence 
flyout: Start	Sequence, Start	Sequence	by	Vector, Start	Sequence	by	List, and Start	
Sequence	by	Traits.

The Start	Sequence	command has two uses. The first usage is to arrange the database order 
of  the shapes, which determines the order in which the shapes are output to a cutter. The 
second usage is to arrange shapes graphically on-screen.

crEatIng a sEQuEncE
1. Select the first shape.
2. From the Layout	menu, choose Sequence, and Start	Sequence.
3. Click each subsequent shape, one-by-one. A connecting line is drawn as each shape is 

clicked.

Fig. 71 - Additional alignment options.
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4. Click on an empty portion of  the workspace to finish editing.

The Start	Sequence	by	Vector	command is similar to the Start	Sequence command, 
except that multiple shapes are added to the sequence by drawing a line. 

crEatIng a sEQuEncE by vEctor
1. Select the first shape.
2. From the Layout menu, choose Start	Sequence	by	Vector.
3. Click and drag the cursor to form a line. All shapes that are intersected by this line will 

become part of  the sequence.
4. Click on an empty portion of  the workspace to finish editing.

Both the Start	Sequence and Start	Sequence	by	Vector	commands can be used to arrange 
shapes. Repeat steps (1-3), and then right-click and drag the shapes across the workspace.

The Start	Sequence	by	List command will open the Sequence	by	List dialog, which 
provides a visual list of  all the shapes that are on the workspace. Shapes at the front of  this 
list will appear above other shapes, and shapes at the back will appear below. The mouse can 
be used to drag shapes within this list. Alternatively, select a shape and use the To	Front, To	
Back, Forward	One, and Back	One	buttons. To use the Reverse	Order	button, at least 
two shapes must be selected.

 □ Holding the [Shift] key will align the shapes according to their lower-left bounding box 
corner.

 □ Holding the [Control] key will constrain the shapes either vertically or horizontally.

The Start	Sequence	by	Traits command will open the Sort dialog, which will arrange the 
shapes according to their horizontal, vertical, or relative (Nearest) positions. Alternatively, 
the Database order arranges the shapes according to the order in which they were created.

nesting
From the Arrange	menu, the Nesting	command (Fig. 72) is used to rearrange shapes into 
the minimum area necessary for printing or cutting the shapes. In this manner, the amount 
of  wasted media required to output the shapes is minimized. Nesting may also be used to 
rearrange shapes across a non-rectangular area, such as leftover media.

To nest the individual letters of  a sentence, the Text	to	Graphics	command must be used 
first. Otherwise, the entire sentence will be nested without rearranging the individual letters.
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	□ Specify	Corners:	Choose the corner from which rearranged shapes will be placed. 
Nesting will begin in that corner and extend across the plate size.

	□ Directions:	The direction in which shapes will be nested across the material.
	□ Rotation:	Allow rotation of  shapes by the specified maximum number of  degrees. If  

20 degrees, then shapes will be rotated in increments of  20 degrees to find the optimum 
placement.

	□ Nesting	Border:	The minimum distance to maintain from the material edge.
	□ Clearance	Between	Objects:	The minimum distance between shapes.
	□ Error	Factor	of 	Clearance:	For expert EngraveLab users, a value that is used to adjust 

nesting based on the average shape sizes.
	□ Allow	Mirrored	Parts:	Allow objects to be flipped horizontally or vertically during the 

nesting process.
	□ Keep	Groups	Intact:	If  this option is off, then grouped shapes will be separated 

during the nesting process.

Error Factor oF clEarancE
During the nesting process, approximations are made that are based partly on the magnitude 
of  the shapes being nested. Setting a small Error Factor will produce more consistent 
spacing between the shapes, but at a cost of  more processing time. The following chart 
provides suggested Error Factor values, which are qualified by the broad categories of  Fine, 
Medium, and Coarse. The table is based on the average dimension (inches or millimeters) of  
the shapes being nested.

Shape Dimension Fine Medium Coarse
0 < Size < 100 0.1 0.2 0.5

100 < Size < 1000 0.2 0.5 1.0
1000 < Size < 3000 0.5 1.0 2.0

Size > 3000 1.0 2.0 5.0

Fig. 72 - Nesting controls available from the SmartBar.
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badges
From the Layout	menu, the Badges	command is used to serialize text data. For example, 
badges are used to create name plates for doors, identification cards for employees, and 
adhesive labels for schematics.

From the Badge	Setup dialog, the Plate	fields indicate the Width, Height, and Margins 
that will be used when distributing the badges across the plate size. The Spacing	fields, 
Vertical	and Horizontal, indicate the amount of  space to maintain between badges.

The Page	Preview	shows how the badges will be distributed across the plate size. Badges 
can be arranged either vertically (top-to-bottom), or horizontally (left-to-right).

The Use	Score	Lines	option is used to insert score lines between each badge, so as to 
improve the ease of  separating the badges after production. Use the Color	picker to set the 
score line color.

Enabling the Use	Plate	option will limit each badge to a single plate size. If  the Use	Plate	
option is enabled, then the margins will be cleared to zero.

Where the generated badges require more area than the plate size, then the Paging	Tool	is 
used to browse the additional plate sizes. The Paging	Tool is at the bottom-right corner of  
the workspace.

sEttIng platE sIzE and margIns
 □ When routing or engraving, it is recommended that the Height and Width be set to the 

exact dimensions of  the plate.
 □ When rendering a vinyl sign, set the Height and Width to match the page size of  the 

plotter.
 □ When cutting or plotting, set the margins equal to the cuttable area of  material, not 

necessarily the actual size.

The Number	of 	copies	indicates the total number of  badges to be created. The Total	
Number	of 	Pages	indicates the number of  plate sizes that are required to display the 
badges, and Max	copies	per	page	indicates the number of  badges that can be displayed per 
plate size.

If  the badge text has been applied with text compression, then the Compress	Equally	
Over	Copies	option is available. Enabling this option will cause all badges to be evaluated 
to determine the maximum amount of  text compression required (if  any) to fit replacement 
text within the badge margins. For consistency, all badges will then be applied with an equal 
amount of  text compression.

The Replaceable	Items	/	Text	list displays all text shapes that are available for substitution. 
The text of  each item will correspond to the text that had been entered on the workspace. 
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Select the text objects that will undergo substitution. If  a text shape is not selected within 
this list, then no substitution for that text will take place.

The Replacement	Data	File	contains the text that will be substituted for each badge. 
The order of  fields in the Replacement	Data	File	should correspond to the order of  text 
shapes on the EngraveLab workspace. This will allow the Badge	Setup	dialog to substitute 
text in the correct order.

rEplacEmEnt data FIlE
Any text editor may be used to create the Replacement	Data	File. Within the text file, each 
line represents a set of  data for one badge. If  the badge has multiple fields, then each field 
must be separated by a delimiting character, such as a comma, a space, or a tab character. For 
example, tab-delimited data might appear as follows:

Text	Field	1		[TAB]		Text	Field	2		[TAB]		Text	Field	3

Next to the Browse button, the drop-down list may be used to choose the delimiting 
character that is used in the text file.

If  there are more badges being created than there are sets of  data, then the extra badges will 
be filled with empty data.

badges – text substitution
From the Badge	Setup dialog, click OK	to continue. If  one-or-more text fields were 
selected within the Replaceable	Items	/	Text	list, then the Text	Substitution	dialog will 
open. Each column represents one of  the items from the Replaceable	Items	/	Text list. 
If  a Replacement	Data	File had been specified, then the column entries will be filled using 
data from that file. To type text, select a cell and type within the Edit	Text field.

Within the Text	Substitution	dialog, a column (or range of  cells within a column) can 
be serialized. For example, click a column header to select all the cells within that column. 
The Serialize dialog will open, which is used to indicate the Start value for the series, the 
Increment value between each cell, and whether Number or Character values will be used.

The Start value may be either numeric, alphabetic, or alphanumeric. For alphabetic series, 
the ASCII character set is used. When badges have incremented through the entire ASCII 
character set, then subsequent badges will continue from the beginning of  the set.
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sErIalIzIng data – sEt basE
When serializing badge data, the Start field is used as the base value, to which the Increment 
is added for each subsequent badge. By highlighting only part of  the Start field data, the 
selection will be incremented, and unselected portions will remain constant. For example, 
suppose a series of  booth labels must be created for a trade show.

As in the screen shot (Fig. 73), the value “Booth A” is typed. Using the mouse, only the 
‘A’ was highlighted, and then the Set Base button was clicked. This indicates that the word 
“Booth” will remain constant, while the highlighted portion will be incremented for each 
badge.

Fig. 73 - Highlight the letter or number that 
will be incremented, and then click the Set 
Base button.
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Chapter 4

importing images

In This Section…
 □ Importing and exporting files
 □ Publishing to PDF
 □ Browsing Clip-Art
 □ Scanning and tracing images
 □ Aligning scanned images to a baseline
 □ Configuring a Digitizer Tablet

importing files
EngraveLab supports a wide range of  commonly used file formats, such that you can work 
in the design environment that is most comfortable for you. The resulting design can then 
be brought into EngraveLab for further output preparation.

The type of  file format determines the type of  data that can be contained within that file. 
For example, a bitmap (BMP) file contains image data, whereas a plotter file would contain 
vector data. Some file formats can contain both image and vector data.

From the File menu, choose Import. The Import dialog will open.

 □ When importing with the Merge	option checked, the imported file will be added to the 
existing workspace objects. 

 □ If  the Merge	option is unchecked, then the existing workspace objects will be deleted.
 □ For certain types of  files, the Customize	button will become active in order to specify 

certain parameters for the given file type. For example, if  the Files	of 	type	drop-list is 
set to Bitmap	Files	(*.bmp), then the foreground and background of  monochrome 
bitmaps can be set.

 □ The Filter	button is used to customize the file types that are listed within the Files	of 	
type	drop-list.

 

After a file has been chosen for importing, one-or-more further import options dialogs will 
query how elements of  the given file should be imported. The import options will vary 
according to the type of  file being imported.
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The EngraveLab Reference Guide contains more information about how to import the 
following file formats:

cadlInk Formats
 □ CADlink (CDL) Files
 □ CADlink Backup (BAK) Files

common Formats For ImagEs
 □ Bitmap (BMP) Files
 □ JPEG Files
 □ TIFF Files
 □ Adobe PhotoShop (PSD) Files

common Formats For lInE art and/or ImagEs
 □ Adobe PDF Files
 □ Adobe Illustrator (AI) Files
 □ Adobe Encapsulated PostScript (EPS) Files
 □ AutoCAD (DXF) Files
 □ CorelDraw (CDR) Files

altErnatIvE and lEgacy Formats
EngraveLab supports a broad variety of  alternative and legacy file formats, which will 
convert the file objects into native EngraveLab objects. In this manner, designs from older 
third-party or discontinued software packages (or older versions of  Windows) can be reused. 

Note: EngraveLab does not include an import filter for the AutoCAD (DWG) file format. 
Instead, export from AutoCAD using the DXF format, and then use the “AutoCAD DXF” 
format when importing into EngraveLab.
EngraveLab does include DWG import filters for GraphicCAD, GenericCAD and 
MonuCAD. When importing such DWG files into EngraveLab, take care to indicate the 
correct import filter (e.g., GraphicCAD *.DWG).

exporting files
Note:	For comments about common file types, see Importing Files in the Help File.

 

To send a design to another EngraveLab user, it should be sufficient to save (File menu >> 
Save) the design in CDL format. Alternatively, there are four methods of  exporting from 
EngraveLab:

	□ File	menu >> Save	Embedded	File	– For designs that have linked images (e.g., using 
the Pattern Fills tool), save all such linked images as embedded images. The resulting 
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size of  the CDL file will be increased, thought it can now be sent to another designer 
without worrying about broken links.

	□ File	menu >> Export	– Use this method to save in file formats that store both images 
and cut paths (i.e., EPS files, AI files, etc.), or that support only cut paths (i.e., DXF 
files).

	□ File	menu >> Export	Image	– Use this method to save in file formats that support 
only images (e.g., BMP files, JPEG files, TIFF files, etc.). The Export	Image dialog will 
prompt for the Color	Depth and Resolution at which the image will be exported.

	□ File	menu >> Publish	to	PDF	– Use this method to save the workspace as a PDF file 
that can be sent as a proof  to the customer.

mInImIzIng obJEct nodEs whEn ExportIng
In the lower-left corner of  the Export dialog is the Customize	button, which can be clicked 
to open the Parameter	Specification	dialog. The available controls on this dialog vary 
according to the file type, though generally this dialog is used to specify the export error 
tolerance.

As a rule, the default error tolerance (0.001 or 1/1,000 of  an inch) will work well with most 
files to reduce the number of  exported object nodes. However, if  the default values are 
insufficient, then a caution is urged against setting a high error tolerance.

Clip-art
From the Layout	menu, choose the Clip	Art	Viewer	to browse the clip-art that was 
installed from the CADlink Fonts & Sign Clip-Art CD. Either bitmap (.BMP) or CADlink 
Drawing files (.CDL) are valid formats that may be imported as clip art.

sCanning artWork 
From the File	menu, the Acquire	Image	command is used to scan images from an attached 
scanner. Before using this command, the scanner and scan software must already have 
been installed. For more information about using the scanner software, consult the scanner 
software documentation.

As a suggestion, set your scanning software to scale the artwork by a large amount, such as 
an increase of  1000% (one thousand percent). This will provide a more detailed image that is 
easier to work with in EngraveLab.

If  the scanned artwork is of  low quality, then it may be desirable to use a low dpi when 
scanning (say 75 dpi). Otherwise, a high dpi will merely magnify any mistakes that are in the 
artwork.

Where there is more than one scanner, the Select	Source	command is used to choose 
between the available scanners.
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The Acquire	command will activate the scanner software in preparation for scanning the 
artwork that is on the scanner bed. 

The Acquire	Vector command is similar to the Acquire command, except that it will load 
the artwork into EngraveLab as vector artwork.

The Scan	and	Trace	Wizard	provides a series of  wizard steps that guide you through 
the process of  bringing an image into EngraveLab and then tracing that image into vector 
artwork.

Note: See also Vectorize	Wizard in the index.

When tracing scanned artwork, use a low Tolerance setting to avoid creating a large number 
of  nodes.

After tracing is complete, the resulting shapes are grouped. To node edit these shapes, 
perform an Ungroup command, and then apply a Make	Path operation. The resulting 
shape can then be node edited.

sEttIng thE allowablE Error
Under the Arrange	menu, the Convert	to	Curves command is used to convert line art into 
bézier curves. Once converted into béziers, the line art should scale more smoothly. When 
converting, set the Allowable	Error to one-hundredth (1/100) of  the smallest dimension of  
the shape. 

1. Suppose the line art measures 8 by 14 inches.
2. Units do not matter, so just take the smaller value (8), and divide by 100.
3. Therefore, the error should be 0.08 .

alIgn to basElInE
From the Layout	menu, the Align	To	Baseline	command is available from the Arrange	
and	Distribute	flyout.

For images that are scanned into EngraveLab, it may be the case that the objects are slightly 
misaligned with the plate size. The Align	to	Baseline feature allows these objects to be 
aligned to either the horizontal or vertical plane. In addition, images can be aligned to a 45 
degree angle, or a custom angle may be set.

Before performing the alignment, a line must be defined along the edge the image. To define 
this line, two points must be set. Clicking within the workspace will set the first point (the 
point of  rotation), and clicking again will set the second point (the snap point). When a 
snap angle is applied, the line will be aligned to match the indicated angle, and the image will 
remain aligned with the line.
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digitizing tablets
From the Edit	menu, the Digitizing	Setup… command is used to configure a digitizing 
tablet.

Though no other intermediary software drivers are required for the tablet to be used with 
EngraveLab, please ensure that the tablet is correctly connected to the computer, according 
to the manufacturer instructions.

The Enable	Digitizer option is used to enable and disable the digitizer. In order to 
reduce the load on the system, it is recommended that the digitizer be disabled when not 
in use. This will prevent EngraveLab from polling the tablet, and therefore free up system 
resources.

The Track	Pen option is used to enable and disable the tracking of  the digitizing pen. In 
order to reduce the load on the system, it is recommended that the pen be disabled when not 
in use.

The Reset	Baseline option is used when starting a new drawing, or if  the original angle and 
position of  the tablet baseline need to be restored. The baseline of  the tablet will be reset to 
match that of  the material.

The Set	Baseline option is used to align the baseline in EngraveLab with that of  the 
artwork (Fig. 74). This avoids the requirement that the artwork be precisely aligned with the 
bottom of  the tablet.

Fig. 74 - Using points of reference within the artwork, 
click to set each end of the baseline . In the SmartBar, 
choose the angle that the baseline will snap to.
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Chapter 5

editing bitmap images

In This Section…
 □ Setting memory resources for Undo
 □ Types of  images (Image Mode)
 □ Creating bitmap images from line art
 □ Applying three-dimensional chiseled or beveled patterns
 □ Resizing images using the Super Size tool
 □ Easy image clipping with Fluid Mask
 □ Applying color adjustments, filters and plug-ins
 □ Editing images with AccuScan
 □ Vectorizing images into line Art
 □ Photo manipulation using GIMP
 □ Using PhotoMachine to line-trace an image

setting undo resourCes
Before we get started with editing bitmap images, we should highlight the fact that large 
images can require quite a bit of  your workstation memory and hard drive space. This is 
particularly significant with respect to performing Undo operations to backtrack over your 
bitmap editing. If  the number of  Undo steps (and their required memory) exceeds the 
allocated resources, then older Undo	steps will be discarded.

If  you want to have more resources available for your Undo	operations, then from the 
EngraveLab Options	menu, choose EngraveLab	Setup	>>	Undo	Setup. 

scratch dIsk mEmory
The total amount of  Undo	Setup memory is the sum of  your workstation memory and 
its available hard drive space. Knowing this limit, you have the freedom to increase the 
maximum amount, while keeping in mind that you want to leave enough resources for other 
applications. As such, this is a personal judgement call, but you can generally increase the 
maximum a certain amount, and if  you are finding that there aren’t enough undo when 
working with your bitmaps, then increase the maximum amount again.
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types of images (image mode)
There are five image types available for image editing: CMYK, RGB, Grayscale, Indexed 
Color, and Monochrome. To change the type of  bitmap in EngraveLab, use the Image	
menu >> Mode	flyout.

 □ The CMYK type is typical of  subtractive color mixing (i.e., printed images). This mode 
is used where specific CMYK values are envisioned for a design, and it is desirable to 
avoid possible rounding differences that might occur when printing RGB images (i.e., 
converting RGB to CMYK when printing).

 □ Under Windows, the RGB	type has the highest color depth, and as such is often 
referred to as a full-color bitmap, a 24-bit bitmap, or an image that has “millions of  
colors.

 □ Converting a bitmap to Grayscale	will discard all the color information within the 
image. Converting to grayscale is a common activity when tracing an image into cut 
paths, or when preparing an image for laser engraving.

 □ To reduce file size, bitmaps are sometimes saved as Indexed	Color	bitmaps, which can 
appear more granular because the total number of  colors are limited to either 256 or 
16 colors. As such, indexed color bitmap are not commonly used with high-resolution 
images , unless a particular effect is desired.

 □ For Monochrome bitmaps, note that Windows defines a monochrome bitmap as a 
two-color image, where white is the default background color, and black is the default 
foreground color. However, these defaults can be modified via Options menu >> 
EngraveLab	Setup >> Import	Bitmap	Setup.

rendering bitmaps
From the Transform	menu, the Render	to	Bitmap	command is used to convert a shape 
into a rectangular bitmap.

When the bitmap is created, empty portions of  the bitmap will be set to white. However, 
AccuScan can be used to make the white transparent.

transparEnt bItmap background
1. Suppose that a bitmap has a white background that needs to be set as transparent.
2. Double-click the bitmap to enter AccuScan	mode.
3. Above the Palette button, set the Target	Color	to white.
4. Press [Ctrl] and then left-click the Target	Color.

From the Transform	menu, the Render	Contour	Bitmap	command uses process colors to 
create three-dimension chiseled or beveled patterns. The Constant	Slope	option will cause 
the chisel/bevel effect to reach its maximum height/depth at the same rate. For areas of  
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the bitmap that have a short distance between the edge and center, the bitmap will tend to 
plateau. The Constant	Height	option will cause the chisel/bevel effect to dip/peak along 
the centerline of  the shape. 

resizing images
On the EngraveLab workspace, images are treated like objects that can be resized according 
to the job requirements. However, resizing will not change the image resolution. To increase 
the image resolution, either use the Image Size or Super Size Image commands.

ImagE sIzE
From the Image menu, the Image	Size command displays size and resolution parameters 
for the selected bitmap. The Pixel	Dimensions refers to the on-screen image size listed in 
pixels. The Resolution is listed in pixels per inch (i.e. like dpi or dots per inch). The Image	
Dimensions are the actual size at which the image will be printed or cut, expressed in the 
current ruler units.

supEr sIzE ImagE
From the Image	menu, the Super	Size	Image	is similar to Image	Size, except that more 
processing time is required to retain the detail quality of  the original image.

1. On the EngraveLab workspace, scale the image to the desired print dimensions.
2. From the Image	menu, choose Super	Size	Image.
3. Set the desired resolution quality of  the image.
4. Click Apply, and the Zoom	Engine	dialog will open.

(If no change in resolution has been specified, then clicking Apply will be ignored.)
5. Adjust the Zoom	Engine	controls to retain the desired quality, and then click OK.
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fluid mask - easy image Clipping

Note: Fluid Mask is an add-on feature that can be purchased for use with EngraveLab.

Fluid Mask is an intuitive tool for knocking out the background of  an image, such as a 
photo of  a person standing before scenery. The process is very much like a paint-by-
numbers coloring book, where you paint with a green brush (the Keep brush) to indicate the 
foreground, and paint with a red brush (the Delete brush) to indicate background.

Suppose that you have a customer photo, such as a JPEG image of  their child that was taken 
using a digital camera (Fig. 75). However, the background of  the image is cluttered and 
needs to be clipped using Fluid Mask.

1. Import the image onto the EngraveLab workspace, select it, and then choose Image	
menu >> Fluid	Mask.

2. The Fluid Mask editing mode will launch, and the image will be analyzed in order to 
automatically identify similar regions of  color and texture.
Several seconds may be required, and the resulting regions will appear much like a 
paint-by-numbers coloring book.

3. Along the top of  the Fluid Mask window are three tabs: Source, Workspace, and Cut-
out. The Workspace	tab should be active.

4. On the left-hand side is the Tools	toolbar.
5. From the Tools	toolbar, choose the Delete	Local	Brush	tool (Fig. 76).
6. With this brush, move the cursor over part of  the background image and then left-click.

Notice that regions that were overlapped by the brush have now been filled with a red 
mask.

Fig. 75 - Using Fluid Mask: (a) the original image, (b) after 
Fluid Mask has identified common regions, and (c) the 
finished image with clipped background.
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7. Continue to click other portions of  the background, such that you are filling in the 
background with a red mask (i.e., this portion is being marked for deletion).
In addition to clicking, you can also click-and-drag to paint over an area.

8. If  necessary, remove the tick from the Show	Object	Edges	checkbox. This will hide 
the regions, such that you can distinguish any portions of  the background that were 
missed.

9. When you have finished painting the background red, choose Image	menu >> Auto-
Fill	Image.
The foreground of the image will be automatically painted green (i.e., the foreground 
will be kept).

Also, a blue blending line will automatically indicate the transition region between red 
background and green foreground.

10. From the Tools	toolbar, click the Create	Cut-Out	button.
11. From the File	menu, choose Save	And	Apply.
12. The Fluid	Mask	window will close, and the view will return to EngraveLab.
13. The Prime	dialog will query whether a primer should be automatically applied to the 

image. For the sake of  this example, choose No and click Close.
14. The resulting image with clipped image will be placed on the EngraveLab workspace.

Fig. 76 - From the Fluid Mask Tools toolbar, use 
the Delete Local Brush tool for painting the red 
background mask.
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FluId mask commEnts

Green for foreground, Red for background
 □ In our example, we used a red brush to paint the background mask, and then we used 
Image menu >> Auto-Fill	Image to automatically complete the foreground mask.

 □ Depending on the image, we may have found it easier to use a green brush to paint the 
foreground mask, and then use Auto-Fill	Image to complete the background mask.

Blue for busy edges (e.g., hair, fur and feathers)
 □ For images that have busy edges, the easiest procedure is to first use the Blend	Exact	
Brush (blue) with a thick brush to paint those edges, and then use a thin brush to trace 
the remainder of  the principle image.

 □ Once the image has been traced with blue, use the Keep	Exact	Brush (green) to paint 
within the traced image.

 □ Optionally, use Image menu >> Clean	All	Blend and Clean	All	Keep to catch any 
stray pixels that you may have missed.

 □ Then use Image menu >> Auto-Fill	with	Delete to complete the background.

Local Brush and Exact Brush
 □ For both green and red, there is a Local	Brush and an Exact	Brush.
 □ Use the Local	Brush to paint regions.
 □ Use the Exact	Brush to paint only pixels (i.e., this is a fine editing tool).

Increase the brush size
 □ Use the square bracket keys ‘[‘ and ‘]’ to change the brush size.

Increase the brush strength
 □ A brush with strength zero will affect only the regions that you touch with the brush.
 □ A strength greater than zero will cause adjacent regions to be painted (e.g., like a damp 

brush).

Use the Clean Tool
 □ After most of  a background or foreground mask has been filled, choose the Tools 

toolbar >> Clean	Tool, and then click the given mask. Any speckles within the mask 
will be automatically painted.

Hide the Region Edges
 □ Along the bottom of  the Fluid Mask window is the Show Object Edges checkbox. 

Remove the tick to reveal missed areas.

Undo the Paint Steps
 □ If  you have painted the wrong portion of  the image, then use the Edit menu >> Undo 

command. The shortcut for Undo is [Ctrl	+	z].
 □ Alternatively, from the Tools	toolbar, use the Erase	Brush	(there are both Local and 

Exact versions).
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Zoom 
 □ Press the ‘z’ key to activate the zoom magnifying glass, then marquee-select the zoom 

region.
 □ To see the full size image, use the [Ctrl	+	0] shortcut (control + zero).
 □ Use the ‘+‘ and ‘-’ keys to zoom in and out.

image menu - Color adJustments
From the Image	menu, there are flyouts for both Easy	Color	Adjustments, and Color	
Adjustments. The Easy	Color	Adjustments	are automated settings that can be used 
to quickly improve image quality. For greater control over the image, use the Color	
Adjustments	flyout.

Easy color adJustmEnt tools:
Note: These tools can be applied multiple times to achieve the desired effect.

	□ Cleanup	Black	- Improve the contrast (i.e., appearance of  details) within dark regions 
of  the image.

	□ Cleanup	White	- Improve the contrast (i.e., appearance of  details) within light regions 
of  the image.

	□ Make	Lighter	- Reduce the depth of  shadows within the image (e.g., increase the 
brightness).

	□ Make	Darker	- Tone down the highlight regions of  the image (e.g., improve details in 
the light portions).

	□ Increase	Saturation	- Strengthen the distinct hues within the image.
	□ Blur	Image	- Soften details within the image.
	□ Sharpen	Image	- Increase the contrast of  details within the image.

color adJustmEnt tools:
	□ Levels	– Adjust the distribution of  color intensities throughout the bitmap, either to 

correct a scanned image, or to create an artistic effect.
	□ Contrast/Brightness…	– The Contrast	setting is used to modify the perceived 

difference between light and dark areas of  the bitmap. The Brightness	setting is used 
to modify the overall intensity of  the bitmap.

	□ Hue/Saturation…	– Adjust the Hue, Saturation, and Lightness values of  the bitmap.
	□ Curves…	– Adjust the tonal range (shadows, midtones, and highlights) of  the bitmap.
	□ Invert	– Inverts the colors in the bitmap, making it like a photographic negative. This 

feature can also be used to invert the color of  a grayscale image, making the black white 
and the white black.

 □ Posterize…	– Limit the number of  color levels per plane (red, green, and blue). For 
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example, two levels means two of  red, two of  green, and two of  blue.
	□ Histo	Contrast…	– Increases or decreases the contrast of  the bitmap image, using a 

histogram to determine the median brightness. Once the median brightness has been 
determined, pixel values above the median are brightened, and pixel values below the 
median are darkened.

	□ Stretch	Intensity	– Increase the color contrast in the bitmap without changing the 
number of  discrete intensity values (ordinary contrast adjustments can lose high- and 
low-end values).

	□ Histo	Equalize	– Linearizes the number of  pixels in the bitmap, based on the specified 
color space (RGB, Grayscale, etc.).  This can be used to bring out detail in dark areas of  
an image.

	□ Balance	Colors…	– Redistributes the RGB values of  individual bitmap pixels. For 
each pixel, its red, green, and blue components are isolated, and the color sliders are 
then used to increase or decrease the percentage RGB values within each pixel. In this 
manner, a color cast can be removed from the bitmap, or a color tinge can be created 
for an artistic effect.

	□ Swap	Colors…	– Swap the color channels of  the original bitmap. This feature is useful 
for obtaining artistic effects that would otherwise be difficult to achieve using the other 
Color Adjustment tools.

image menu filters
From the Image	menu, the Filters	flyout provides a selection of  effects that can be applied 
to bitmap images.

sharpEn FIltErs:
	□ Sharpen	– Increase or decrease the sharpness of  the bitmap.
	□ Unsharp	Mask	– Despite its name, this is actually a sharpening function because it 

increases the contrast between light and dark areas of  the bitmap. Wherever there is a 
brightness transition between light and dark, the light area is made lighter, and the dark 
area is made darker, such that the transition becomes more distinct.

blur FIltErs:
	□ Average	– Changes the color of  each bitmap pixel to the average color of  pixels within 

the surrounding pixels. This results in a blur effect.
	□ Gaussian	Blur	– Smooth or blur pixels with respect to their surrounding pixels. The 
Radius	determines the surrounding area that is considered when blurring a pixel.

	□ Motion	Blur	– Blur the bitmap to create the illusion of  movement within the image. 
Positive angles indicate a clockwise blur, and negative angles indicate a counter-
clockwise blur.

	□ Median	Filter	– Changes the color of  each bitmap pixel to the median color of  pixels 
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within the surrounding pixels.

noIsE FIltErs:
	□ Add	Noise	– Add random pixels to the bitmap. Adding noise can be an effective 

means of  making an image appear older or dirtier, especially where the purpose is to 
distract the eye from imperfections in the original image.

	□ Despeckle	– Removes speckles from the bitmap, such as those present in scanned 
images.

stylIzE / artIstIc FIltErs:
	□ Emboss	– Applies an emboss effect to the bitmap, letting you specify the depth and 

direction of  the effect.
	□ Solarize	– Creates an effect that mimics the accidental exposure of  photographic film 

to light. This is done by inverting all color intensities that exceed the Threshold	value.
	□ Oilify	– Create an oil-painting effect. For each pixel, the Amount	indicates the number 

of  surrounding pixels that are considered when creating the effect.
	□ Mosaic	– Create a mosaic effect by dividing the bitmap into tiles of  the specified size, 

and then averaging the pixel colors within each tile.
	□ Spatial	Filter	– An assortment of  artistic filters.
	□ Halftone	– Converts a bitmap with any resolution to a halftoned bitmap. A halftoned 

bitmap is a 1-bit bitmap that has been dithered for black and white printing or display.
	□ Intensity	Detect	– Set all pixel color intensities to 255, or clear them to zero. If  a 

pixel’s intensity is between Low and High, then set the intensity to 255. Otherwise, clear 
the intensity to zero.

rEmovE rEd EyE
 □ Removes the “red eye” effect that results from flash photography. For each pixel, only 

the red color component is evaluated.
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image menu plug-in filters
Plug-ins are software modules that are used to create special effects for bitmaps. These 
modules may be obtained through either Adobe or third-party plug-in developers.

After plug-ins have been installed on your computer, go to EngraveLab and use Image	
menu >>	Options	>>	Plug-In	Paths	to indicate the hard drive location of  the plug-ins. 
The plug-ins will then be available under the EngraveLab Image menu.

Note:	Some plug-ins require that a foreground and background color be set. In this case, 
use the Set	Foreground	Color	and Set	Background	Color	commands.

thE plug-Ins hElpEr dIalog
Whereas plug-ins are typically designed only for bitmaps, EngraveLab can also apply plug-ins 
to line art, or to a combination of  line art and bitmap objects (Fig. 77).

By using line art as the basis for your plug-in effect, the resulting effect can be clipped to the 
line art.  In this way, the following advantages are obtained:

1. The “empty” portions of  the plug-in bitmap are usually set to a white color, which 
are undesirable when arranging the bitmap with surrounding objects. Clipping to the 
original line art will hide the empty portions of  the bitmap.

2. The bitmap that is produced by the plug-in will often have a jagged edge, which will 
look poor when scaled up to a large poster size. Clipping will “trim” the jagged edge, 
such that scaling is acceptable.
Note: A good alternative to case (2) is to scale your original line art to the desired size 
before applying the plug-in effect. Line art shapes will scale without diminishing their details.

Fig. 77 - When plug-ins are applied to 
line art, the Plug-ins Helper dialog is 
used to define how the effect will be 
applied to the line art.
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plug-Ins: rIchard rosEnman™ collEctIon
Note:	More about Richard Rosenman’s work can be read about here: 
www	.	richardrosenman.com/profile/biography

EngraveLab includes four plug-ins from Richard Rosenman. The plug-ins are available from 
the Image menu >> Richard Rosenman flyout. The available plug-ins are:

	□ Diffuse	Glow	– Produces an almost angelic glow.
	□ Lens	FX	– Produces an assortment of  distortion effects, as would be possible using a 

camera lens.
	□ Pinch	– Similar to using Lens FX to create a pinch effect, except there is greater 

control over the vertical and horizontal distortion.
	□ Scanlines	– Creates horizontal or vertical lines that can suggest transitions or images 

viewed on a low-resolution video display.

plug-Ins: rEdFIEld™ collEctIon
Note:	More Redfield plug-ins are available through the Redfield web site: 
www.	redfieldplugins.com

EngraveLab includes five plug-ins from Redfield. The plug-ins are available from the Image	
menu >> Redfield	flyout. The available plug-ins are:

	□ Craquelure	3D	– Creates a variety of  texture effects.
	□ Jama	3D	– Creates corrugated and cellular patterns.
	□ Lattice	Composer	– Creates grids and weave patterns.
	□ Seamless	Workshop	– Creates seamless tiles.
	□ Water	Ripples	– Creates a variety of  water ripples effects. 
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plug-Ins: harry’s FIltErs™
Note: More of  this type of  plug-ins are available through the Plugin Site: 
www.	thepluginsite.com

EngraveLab includes sixty-nine (69) plug-ins that are available through a single dialog 
interface. From the Image menu, choose The	Plugin	Site >> Harry’s	Filters. The 
available plug-ins are:

Color
	□ Add	Color – Adjust the RGB color channels within the image.
	□ Cartoon	Art – Assign an off-tone pallor that suggests an artist’s rendition.
	□ Colorize – Vary the image hues as if  the image were based upon a monotone print.
	□ Color	Mood	– Introduce sharp color contrasts.
	□ Color	Wizard – Like Color Mood, except with pastel color contrasts 
	□ Expose – Create over- and under-exposure effects that are reminiscent of  developed 

film.
	□ Twilight	Colors – Sombre mood that suggests dim lighting (e.g., dawn or dusk).
	□ Old	Film – Simulates the graininess of  film that has begun to deteriorate due to age.
	□ Inversity – Stark hues that suggest the presence of  overhead lighting.

Artistic
	□ Atmospherizer – Rotate the spectrum of  colors as if  the image were being viewed 

through a transparent color sheet of  plastic film.
	□ Blurry	Painting – Present the image as if  it were a watercolor or composed of  paint 

daubs.
	□ B/W	Limiter – Attenuate the color values within the image to emphasize its grayscale 

components.
	□ B/W	Limiter	Pro – Combine a grayscale with hints of  color from the original image.
	□ Color	Cocktail – Emphasize kaleidoscopic transitions and color shifts.
	□ Crochet	Art – Superimpose the image with a pattern that suggests the texture of  

knitted cloth.
	□ Equalizer – Suppress color values to produce a more subdued image.
	□ Equalizer	Pro – Suppress color values to emphasize certain hues from the original 

image.
	□ YUV	Intensity – Adjust the image in terms of  YUV color model. Tends to produce 

pastel colors with stark contrasts.
	□ Color	Compress – Produce a posterized appearance with intense hue shifts.
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Gradients
	□ Beam – Subject the image to a strong light source.
	□ Chaos – Introduce sporadic shading throughout the image.
	□ Double	Sphere – Apply a color distortion that exudes from the image center.
	□ Frame – Border the image with the appearance of  vertical color strips that convey a 

sense of  change or progress.
	□ Mixed	Beam – Overlay the image with filtered colors, as if  there were multiple color 

light sources.
	□ Mixed – Shift color regions within the image as if  it were the product of  a complex 

screen print.
	□ Mystic	Mountain – Apply colors with a dream-like quality.
	□ Quad	Beam – Burnish the image as if  it were subjected to sources of  strong white 

light.
	□ Star – Burnish the image as if  it were subjected to an intense source of  white light.
	□ Spirals – Superimpose concentric circles that suggest disorientation or activity.
	□ Triple – Intense hues of  vertical bands or concentric circles.

Patterns
	□ Radial	Sinality – Explosive rays or bands of  varying amplitude that convey energy and 

inspiration.
	□ Sinfinity – Suggestive rays or bands of  varying hues and amplitude.
	□ Rasper – Overlay curves and patterns like images from a contemporary fashion 

magazine.
	□ 70s	Pop – Overwhelm the image with a storm of  multiple color light sources.
	□ Random	Art – Intense rays or bands that suggest mood and transition.
	□ Symbol	Shaper – Horizontal bands that suggest vision and realization.

Warp
	□ Wonderland – Ripple the image like water distortion or waves of  heat.
	□ Tiled	Glass – Divide the image into blocks of  glass.
	□ Swirl – Ripple the image like a sheet that is being blown by a rotating fan.
	□ Picture	Chopper – Ripple the image like a sail that is blowing in the wind.
	□ Glass	Slices – Subdivide the image into fragments or slivers of  glass.
	□ Kamikaze – Rotate and zoom the image.
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Noise
	□ Circular	Noise – Create static like a television that is experiencing poor reception.
	□ Grain	Maker – Introduce a posterization that provides the image with a textured 

appearance.
	□ Nail	Art – Superimpose a lattice of  curved patterns.
	□ Noisy	Blur – Distort the image as if  it were being viewed underwater or from behind a 

panel of  thick glass.
	□ Noise	Reducer – A simple noise reduction filter for imported images.
	□ Digital	Cutter – Divide the image into vertical barcode-like line segments, imposing 

the idea of  digital static.

Encrypt/Decrypt
	□ Black	and	White – Combine up to eight (8) noise channels to produce a convoluted 

amalgam of  the image.
	□ Color – Vary each pair of  sliders (Key 1 and 2, Key 3 and 4, etc.) to resample the color 

regions of  the image.
	□ Moiré	Decryption – Introduce posterization and static that suggest corrupted image 

data.
	□ Moiré	Encryption – Introduce posterization and static that suggest corrupted image 

data.
	□ Noise – Combine up to eight (8) noise channels.
	□ Radial – Subdivide the image into concentric sections that suggest a high-technology 

cyberpunk theme.
	□ Sinus – Apply short horizontal bands of  noise.
	□ Weak – General soft background noise, as would be caused by a loose connector on a 

security monitor.

Other
	□ Convolver – Varying emboss effects that highlight details in the image.
	□ File	Size	Reducer – Discard image data, though at the risk of  losing image detail.
	□ Overpainting – Overlay additional color layers like rough paint strokes.
	□ Quadrant	Flip – Divide the image into four quarters, and then rotate the sections.
	□ Streamer – Create vertical or horizontal motion blur lines.
	□ Zoom – Magnify a circular portion of  the image.
	□ Convolver	Pro – Advanced emboss effects that highlight details in the image.
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Nature
	□ Dawning – Imbue the image with a light source that suggests a rising sun.
	□ Flame – Create flame lines along bottom of  image.
	□ Lightning – Place jagged diagonal lines to simulate a flash of  lightning.
	□ Polar	Lights – Simulate the presence of  Christmas lights.
	□ Super	Nova – Classic transition effects from science fiction movies.
	□ Tornado – Overwhelm the image with the appearance of  high winds and debris.

plug-Ins: alIEn skIn™ samplEr
Note:	More Eye Candy plug-ins are available through the CADlink store: 
www. cadlink. com/ store

EngraveLab includes five plug-ins from Alien Skin. The plug-ins are available from the 
Image	menu >> Eye	Candy	4000	flyout. The available plug-ins are:

	□ Bevel	Boss	– Creates carved, embossed or bevel surface texture.
	□ Chrome	– Create a reflective embossed effect that simulates chrome and other shiny 

surfaces.
	□ Corona	– Projects a halo effect that projects from behind the selection.
	□ Gradient	Glow	– Create soft glows or hard outlines around the selection.
	□ Shadowlab	– Create drop, perspective, and cast shadows.

plug-Ins: FIltEr ForgE™ FrEEpacks
Note: The full Filter-Forge plug-in is available through the Filter Forge web site: 
www. filterforge.com

Filter Forge is a single plug-in that provides both an online repository of  user-submitted 
filters, as well as a filter editor for creating your own effects and textures. In EngraveLab, 
four sample collections are available from the Image menu >> Filter	Forge flyout: Metals, 
Photo Effects, Frames, and Distortions.

Filter Forge Freepack 1 – Metals
The Metals plug-ins provide interesting metallic textures and effects, including industrial 
surfaces, decorative foil, and rust.

	□ Alien	Metal – Creates shiny metallic surfaces that are like science fiction elements.
	□ Brushed	Metal – Creates a brushed metal look that is suitable for backgrounds.
	□ Diamond	Plate – Creates the appearance of  industrial diamond plate flooring.
	□ Foil – Crumpled decorative metal foil that is reflective and shiny.
	□ Metal	Panels – Corroded wall panels that suggest industrial or techno themes.
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	□ Metalizer – Based on brightness levels within the source image, produces polished 
metallic contours.

	□ Rust – Creates a rust texture with transparent areas that can allow a background texture 
to show through.

Filter Forge Freepack 2 - Photo Effects
The Photo Effects plug-ins provide interesting photo effects that either enhance the subject 
matter, or create the effect of  developed photos.

	□ Colorizer – Apply different hues to the highlights, midtones and shadows within an 
image.

	□ Dreamy – Create the effect of  a sunny, dreamy and/or ethereal atmosphere.
	□ Grunge – Create the effect of  a weathered photograph.
	□ LOMO – Simulates the appearance of  photographs created using a classic Russian 

camera, the LOMO Kompakt Avtomat.
	□ Old	Photo – Convert the image to sepia and introduce fading, grain, scratches and 

stains.
	□ Sepia – Convert the image to sepia without adding aged photo effects.
	□ Vibrance – Automatically adjust image levels to enhance its saturation and contrast.

Filter Forge Freepack 3 - Frames
The Frames plug-ins provide borders that can be used as finishing touches for a given image.

	□ Film	Frame – Create a border of  overdeveloped film, such as found with uncropped 
film.

	□ Grunge	Frame – Introduce ragged edges that simulate crumbling, fire-damaged 
photos.

	□ Halftone	Frame – Create an effect along the image edges, such that the edges appear 
to composed of  halftone dots.

	□ Painting	Frame – Place a worn, painted frame around the image.
	□ Photo	Frame – Place an elegant frame around the image.
	□ Simple	Frame – Place a simple, three-color frame with adjustable corner radius.
	□ Watercolor	Frame – Create an effect along the image edges, such that the edges are 

like a watercolor painting.

Filter Forge Freepack 4 - Distortions
The Distortions plug-ins provide effects that simulate how the image would appear when 
viewed through an intervening medium, such as warped glass.

	□ Blur	Shift – Create a significant out-of-focus blur that is like viewing a desert mirage, 
or viewing objects through thick aquarium glass.

	□ Bubbles – Create the appearance of  viewing the image through semi-transparent 
warped (bubbles) glass.

	□ Jumble – Distorted pixel jumble that simulates how a low resolution (dirty) image 
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might appear through military imaging systems.
	□ Noise	Distortion – Waking dream distortions based on the Perlin noise algorithm.
	□ Pattern	Glass – Create the appearance of  viewing the image through semi-transparent 

warped (streaks) glass.
	□ Shatter – Distort the image into a collection of  sharp-edged fragments.
	□ Wave	Distortion – Create the appearance of  viewing the image through semi-

transparent warped (squiggles) glass.

plug-Ins: mEhdI™
Note: More Mehdi plug-ins and examples are available through www.mehdiplugins.com

The Mehdi plug-ins provide a variety of  artistic effects.

	□ Edges	FX – Creates edge-based artistic effects, such as adding thick strokes, or 
simulating a sketched/watercolor appearance.

	□ Kaleidoscope	2.1 – Generate beautiful patterns as if  the image were being viewed 
through a kaleidoscope (i.e., a tube of  mirrors and colored glass).

	□ Projection – Create tiled and optical perspective effects.
	□ Weaver - Simulate a weave pattern using the colors within the original image.
	□ Noise	Shampoo – Simplify the complexion of  the subject matter, such that the image 

colors are more homogeneous like that of  computer-generated artwork.

plug-Ins: cadlInk collEctIon
In addition to the third-party plug-ins, CADlink provides a new set of  in-house plug-ins, 
which are available through the Image menu >> CADlink flyout. The available plug-ins 
are:

	□ KnockMeBlackOut - For printing on black garment material, reduce the amount of  
black ink that is required.

	□ KnockMeColorOut - For printing on color garment material, reduce the amount of  
color ink that matches the garment color.

	□ Transparency	Opacity - Adjust the relative strength of  the transparency layer, thereby 
adjusting the amount of  white underbase that will be printed.

	□ Box	Blur – Add vertical and/or horizontal blur to an image.
	□ Lighting	Effects 	– Combine up to six (6) distinct light sources to create the effect of  

artificially illuminating the image.
 □ Posterize	– Resample the image according to discrete color regions, as would be used 

when creating color separations.
	□ Sphere	Effects	– Introduce one-or-more distortions that simulate raised sphere 

surfaces.
	□ Tilt	Effects	– Change the image perspective to create the sensation of  depth.
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	□ Easy	Color	Adjustments – Like Image menu >> Easy	Color	Adjustments, except 
all of  the controls are provided within a single dialog.

	□ Gaussian	Blur – Smooths or blurs pixels with respect to their surrounding pixels.
	□ Marble	Effect – Generate the appearance of  realistic marble surfaces.
	□ Motion	Blur – Create the appearance of  motion within an image.
	□ Pixelate – Create the impression of  a low resolution image.
	□ Sharpen – Provides a variety of  parameters for improving image crispness.
	□ Sketch – Create the appearance of  a hand sketched artwork.
	□ Wood	Effect – Generate the appearance of  realistic wood surfaces.

bitmap editing using aCCusCan
From the Scan	Tools	flyout, the AccuScan	tool is used to edit bitmaps. Double-clicking a 
bitmap will also activate the AccuScan editing mode. The AccuScan tools (Fig. 78) may then 
be used to edit the bitmap, apply filters and plug-ins, and convert the bitmap into a line-
traced drawing format.

sElEctIon tools
When creating a selection, the [Shift] key may be used to extend the previous selection. In 
addition, the [Control] key subtracts from the previous selection.

	□ Whole	Bitmap:	Select the entire bitmap
	□ Ellipse	Select:	Select an oval area
	□ Rectangle	Select:	Select a rectangular area
	□ Draw	Lasso:	Select a freehand area
	□ Draw	Select:	Define an area that has an irregular shape

Fig. 78 - AccuScan controls within the SmartBar.
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	□ Eyedropper:	Pinpoint a color in bitmap and add it to the Shop Palette
	□ Palette:	Select regions based on specific colors. Colors may be either added or 

subtracted from the current selection.
	□ Magic	Wand:	Select region based on similar colors. The Magic Wand setup may be 

used to customize what is considered to be “similar.”

applyIng FIltErs and plug-Ins
When in AccuScan editing mode, the Image	menu Color Adjustments, Filters, and Plug-Ins 
can all be applied to bitmaps. If  only part of  the bitmap is selected, then the effect or filter 
will only be applied to the selection.

bItmap palEttE colors
Click the Palette button to display the current colors in the bitmap palette. The Image	
Palette	dialog may be used to select palette colors and move them to the front or back of  
the palette.

If  there is not enough space in the palette for new colors, then use the Merge	Colors	tool 
to reduce the number of  palette colors.

transparEnt bItmap color
Above the Palette button is the current Target color. The target color is used with the 
Brush	and Fill	tools.

The target color can be set to be transparent by pressing the [Ctrl] key and then left-clicking 
the Target	color (Fig. 79).

bItmap manIpulatIon tools
The bitmap editing tools are summarized as follows:

	□ Brush	– Edit the bitmap using the Target color.
	□ Move	Region	– Copy the selection and move it to a new location. Press [Ctrl] to fill 

the old region with the Target color.

Fig. 79 - Transparent color controls in AccuScan.
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	□ Crop	Tool	– Trim the bitmap to the selected area.
	□ Fill	Region	– Fill the selected area with the Target color.
	□ Quarter	Bitmap	– Reduce the resolution of  the bitmap by 50% in terms of  its width 

and height.
	□ Extended	Information	– Display information concerning the dimensions and 

resolution of  the bitmap.
	□ Merge	Colors	– Used to remove all unused colors from the bitmap palette, and to 

replace selected colors in the Image Palette dialog with the Target color.
 □ Posterize	Region	– Generating a color palette for a bitmap where none exists, or 

expand/reduce the size of  the bitmap palette.

How to merge palette colors
1. Use the Posterize	Region tool to reduce the number of  colors in the bitmap to 256 or 

less.
2. Beneath the Target color, click the Palette button.
3. The Image	Palette dialog will open.
4. In the Image	Palette dialog, click two-or-more colors, such that they have white 

borders.
5. Click the Merge	Colors button, and the selected colors will be set to the Target color.

veCtorizing images into line art
EngraveLab provides two methods of  vectorizing an image into line art. The classic 
vectorization method provided leading-edge tools that were suitable for previous 
EngraveLab users. The new method uses the Prepare	to	Vectorize	Wizard, which 
introduces new tools for improving the image quality, knocking out the image background, 
and posterizing the image colors prior to tracing.

thE classIc vEctorIzatIon mEthod
The classic method of  vectorizing a bitmap involved the Posterize	Region and Merge	
Color tools to simplify the number of  colors in the image. The following is an overview of  
the classic vectorization method:

Posterize the bitmap
1. In AccuScan mode, click the Posterize	Region tool. 
2.  A dialog will query whether the vectorize wizard should be used. Click No to use the 

classic method.
3. The Posterization	dialog will query for the number of  colors to reduce the number of  

colors in the bitmap, such as 8 or 9 colors.
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Merge similar colors
4. Beneath the Target color, click the Palette button to open the Image	Palette dialog.
5. In the Image	Palette dialog, click the similar colors, such that they have white borders.
6. Double-click the color these similar colors should be merged into. The Target color 

will be set.
7. Click the Merge	Colors button, and the selected colors will be set to the Target color.

Vectorize the bitmap
8. At the far-right of  the AccuScan SmartBar, choose the vectorization settings from the 

drop-list.
9. Click the Vectorization button.
The bitmap will now be vectorized, and the resulting vector shapes will be grouped.

thE prEparE to vEctorIzE wIzard
This vectorization method uses the Prepare	to	Vectorize	Wizard, which involves self-
contained steps for improving image quality, knocking out the image background, and 
posterizing the image colors prior to tracing. The following is an overview of  the Prepare	to	
Vectorize	Wizard steps:

Initial Wizard Settings
1. From the Image menu, choose Prepare	to	Vectorize	Wizard.
2. The initial wizard page will query for Super	Size and Image	Background settings. Use 

the default amount of  memory, click Yes to use Fluid Mask, and click OK to continue.

Zoom Engine (Super Size)
3. The Zoom	Engine	dialog will preview the image at the higher resolution quality.
4. Click OK to accept the default Zoom	Engine settings.

Fluid Mask
Note: If  the Fluid Mask tool is not available, then please skip to step (13).

5. The Fluid	Mask	window will analyze the color regions within the image, and thin 
irregular lines will be used to roughly identify each region.

6. Using the Delete	Local	Brush tool, click background regions of  the image, such that 
they background appears to be filled with red.

7. If  a portion of  the foreground is accidentally filled with red, then use Undo [Ctrl	+	z] 
to correct.

8. If  a portion of  the background is difficult to fill correctly, then use the Delete	Exact	
Brush to manually paint the background by dragging strokes.

9. When the background has been filled with red, choose Image	menu >> Auto-Fill	
Image. The background will remain red, the foreground will appear to be filled green, 
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and a blue “blending line” will appear along the boundary between red and green 
regions.

10. Choose Image menu >> Create	Cut	Out. The image should now appear with the 
formerly red portions “knocked out.”

11. Use [Ctrl	+	s] to save the image back to EngraveLab.

Import Options
12. The following import options will be provided when loading image data back into 

EngraveLab:
 □ The Prime dialog will be available for applying either a primer and/or highlight to 

the image.
 □ The Transparent	Threshold dialog will open. Click OK to accept the default 

value, which is used for controlling visibility of  image pixels.
 □ The Select	Profile	dialog will provide an opportunity to select a new color profile.

Posterization
13. The Posterization	dialog will now allow you to choose the colors that the image will be 

reduced to.
14. The top half  of  the dialog shows the original image before posterization. The bottom 

half  previews the posterization, where Color	1 is pure black by default.
15. Click Color	2 and then click a color in the original image.
16. Likewise, click Color	3 and choose another color in the original image.
17. Continue choosing colors, until the preview has enough colors to appear satisfactory.
18. Increase the tolerance for Color	1 (black), so that shades of  gray are accounted for.

Vectorization
19. Click OK to close the Posterize dialog, and the image is now ready to be vectorized.
20. Double-click the image to access AccuScan editing mode.
21. At the far-right of  the AccuScan SmartBar, choose the vectorization settings from the 

drop-list.
22. Click the Vectorization	button. The bitmap will now be vectorized, and the resulting 

vector shapes will be grouped.
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photomaChine
The PhotoMachine tools are used to convert a bitmap into a line-traced drawing that can 
be cut, routed, or engraved.

PhotoMachine styles:
	□ None	– Produce a grayscale bitmap
	□ Image	Cut	– For use with cutters only. Weeding lines for vinyl are produced, where 

thin bands represent light portions of  the bitmap, and thick bands represent dark 
portions.

	□ Wiggle	– For use with low-resolution engravers. Creates a pattern that appears to 
wiggle across the image.

	□ Output	Tool	Paths	– For use with low resolution engravers. Creates a standard 
engraving pattern.

	□ Squares	– For use with cutters only. A pattern of  variable-sized squares is used to 
depict the image. Smaller squares represent light portions of  the bitmap, and larger 
squares represent dark portions.

	□ Stars	– This style is similar to Squares, except that star shapes are used.
	□ Rain	– For use with laser-engravers. Creates multiple “falling rain” lines for each pixel.
	□ Iron	filings	– This style is similar to Rain, except that all lines are created at random 

angles.
	□ 3D	Image	– Creates a 3D tool path based on the image. For devices that support 

depth control, the tool path may be used to render a three-dimensional relief  image on 
the loaded material.
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Chapter 6

rotary engraving

In This Section…
 □ Configuring the machine
 □ Adding Tools Paths
 □ Previewing the cut job
 □ Registration marks and cutter alignment
 □ Tiling jobs to fit media and machine limits
 □ Filtering cut shapes by color
 □ Recording the lifetime of  the cutting tool
 □ Estimating time required to complete the job
 □ Creating weed borders around script lettering

updating maChine drivers

File menu >> Install >> Cutting	Devices

Windows Start menu >> All	Programs >> EngraveLab >> Cutting	Device	Installation

Before a given machine can be used, its software driver must be installed, which allows your 
computer to communicate with the machine. Once installation has been performed, the 
machine will be available via Engrave menu >> Engraving	Defaults >> Selected	Driver 
drop-list.

Updating Plotter Drivers
New and updated plotter drivers are posted to the CADlink web site as they become 
available. 

1. Go to the CADlink web site at www.cadlink.com
2. Select Downloads and Plotter	Drivers, and then login when prompted.
3. Select the plotter manufacturer, the model, and the CADlink product version that you 

are using.

Note:	The product version can be found via Help menu >> About	EngraveLab, and then 
press the letter ‘ r ‘ for explicit release info.
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Configuring the maChine

Engrave menu >> Engraving	Defaults

Installation of  your EngraveLab involved choosing the machines that would be available. For 
each device that was selected, the corresponding device driver was installed. A device driver 
is the software component that allows the workstation to communicate (i.e., send data) to 
the plotter or cutter.

Important Output Dialog Settings
1. Choose Engrave	menu >>	Engraving	Defaults to open the Output dialog.
2. From the Output dialog, choose the Tool that will be used for plotting or cutting. For 

some cutters, the Tool setting refers to the set of  machine conditions that are being 
used, in which case the Operator’s Manual should be consulted for that cutter.

3. Click the Tool	Options button to view feeds and speeds for the machine. For more 
information about the feed and speed parameters, consult the machine’s Operation 
Manual.

Setting Feeds and Speeds per the Material Type
The Tool	Options dialog parameters can be set according to material type.

1. Choose Engrave	menu >>	Engraving	Defaults >> Tool	Options.
2. The Tool	Options dialog for the machine will open, which displays the available feeds 

and speeds that can be set for the machine.
3. At the top-right of  the dialog, the Material drop-list is used to choose the default 

material that has been loaded into the machine.
4. Once the material has been selected, set the feed and speed parameters accordingly.

Important Engraver Setup Settings
1. Choose Engrave	menu >>	Engraving	Defaults >> Setup to open the Engraver	

Setup dialog

2. On the Engraver	Setup tab, verify that the Machine	Limits are correct

3. On the Port tab, choose the method of  sending cut data to the machine:

□	 Direct	to	port	– This will send the cut data to a machine that is attached to this 
workstation.

□	 Use	Output	Spooler	– This is a legacy feature of  EngraveLab that is kept 
available for seasoned EngraveLab users.
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Creating tool paths

Engrave menu >> Create	Tool	Path

Tools toolbar >> Tool	Path	Tools

By default, newly created workspace shapes are treated like simple contour cut paths 
of  zero depth. To define more sophisticated machining paths, use the Tool Path Tools 
flyout (Fig. 80).

Online
Defines a basic cutting path for which the tool will follow the edge of  a designated 
shape (Fig. 81). The resulting cut will have an offset of  zero. The Online tool path is often 
used to trace shapes in artwork without filling the shapes with an engrave pattern.

Fig. 80 - Except for Drill, the tool paths can also be applied 
through Engrave menu >> Create Tool Path.

Fig. 81 - The Online tool path will trace the 
shape contour.
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Tool Path

Object
Edge



130 EngraveLab 9 User Guide

Male
Defines a basic cutting path on a selected shape, such that the resulting cut shape will fit 
within a corresponding female shape (Fig. 82). The tool path will fall to the outside of  the 
shape contour, such that the offset equals one-half  of  the bit width. The Male tool path is 
typically used to cut shapes out of  a material.

Female
Defines a series of  cutting paths on a designated shape, such that the resulting cut shape 
may contain a corresponding male shape (Fig. 83). For example, consider a polygon shape 
that is cut using a Male tool path, thereby producing a male cut. Suppose then that the same 
polygon shape is cut using a Female tool path, thereby producing a female cut. The male cut 
will then fit within the inner contour of  the female cut.

Fig. 82 - The Male tool path will cut a shape 
that fits within a corresponding female shape.
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Fig. 83 - The Female tool path will cut a shape 
that contains a corresponding male shape.
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Fill
Defines a series of  cutting paths designed to remove material from inside a selected shape.

Note that when simply placing one object within another, a fill operation will engrave the 
outer object without consideration of  the inner object. The correct technique is to combine 
two such objects into a single path, and then the Fill tool path operation may be applied. 
The following steps show how this is done:

Assume that a text logo must be placed within a star shape, all of  which must then be filled 
without losing the text.

1. Create text for the logo. With the text selected, choose Arrange	menu >> Text	to	
Graphics. This will convert the text into a graphic for cutting.

2. Create a star shape that is large enough to contain the logo, and then center the text 
within the star.

3. With both the text and star selected, choose Arrange	menu >> Make	Path. Both 
objects will now have been combined into a single object.

4. Apply a Fill operation to the combined object. The result will be a filled star shape that 
correctly retains the text that was placed within it.

3D Chisel
Defines a cutting process that varies the depth of  a contour tool (usually a conical tool, or 
a V-bit) along the defined path.  The width of  the cut path varies with the depth of  the tool 
path. This type of  cutting is used to create a “hand carved” effect.

Drill
The Drill tool is used to place drill points upon the workspace. Simply left-click on the 
workspace to place a drill point. For a selected drill point, its Depth is editable from the 
SmartBar.

Drill Contour
The Drill	Contour tool will lay a series of  drill points along the contour of  an object or 
group of  objects.

	□ Number indicates the number of  drill points that will be spaced evenly along the 
contour of  the selected object.

	□ Distance between points is used to space drill points evenly along the contour of  the 
object.

	□ Offset is used with the Distance option to indicate an initial gap before drill points are 
placed. After the gap, drill points will be spaced according to the Distance value.

	□ Nodes represent the coordinates that are used for rendering the object on the 
computer screen. Use this option to place drill points according to each node. This 
feature is especially useful when used with polygons.

	□ Nodes	and	Distance will begin by placing drill points according to each node of  the 
object. Additional drill points are then placed according to the distance.
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Drill Center
The Drill	Center tool will place a drill point in the center of  the selected object. If  more 
than one object is selected, then a drill point will be placed at the center of  each object.

previeWing and sending the Job

Engrave menu >> Output

Tools toolbar >> Output	Tool

Engrave Preview mode will display the workspace shapes as they will be cut upon the 
material. The SmartBar displays the current cut settings, as per Engrave menu >> 
Engraving	Defaults. The Cut	Toolbox toolbar provides additional functions that can be 
applied to the job before cutting (Fig. 84).

Except where noted, any settings made using the SmartBar controls or the Cut	Toolbox 
toolbar will not change the default values. Instead, such changes will only apply to the 
current job.

At the far-right of  the Cut	Toolbox, click the Engrave button to send the job. Alternatively, 
if  elements of  the design have been organized according to color, then the Sort	and	Cut	
All	Colors	button can be used to control the order in which the design elements are output 
(See also Filter	By	Color).

Fig. 84 - Engrave Preview will summarize the machine, tool and material in 
the SmartBar. The Cut Toolbox provides additional operations that can be 
performed, including sending the job.
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registration marks
Registration marks are typically used in the following manner:

 □ Where multiple layers of  vinyl are being used to compose a sign fascia, create 
registration marks to help with alignment of  each layer.

 □ When loading printed media into the cutter, some cutter models have a sensor that can 
recognize the registration marks and align the job automatically. For cutters that do not 
include a sensor, the operator will be prompted to manually align the cutter tool with 
each registration mark.

 □ For a sheet a material, a registration mark can be used as a point of  reference that will 
be used to position subsequent jobs (see also Plotter Jog).

Locations of Registration Mark Tools
A. From the Shape	Tools	flyout, the Registration	Mark tool is used to manually place 

registration marks about the artwork.
B. From the Shape	Tools	flyout, the Multi-Registration	Mark tool is used to manually 

offset registration marks about the artwork.
C. In Engrave	Preview mode, the Cut	Toolbox	has a Registration	Mark button. Right-

click the Registration	Mark	button to choose the position, size, and offset of  the 
registration marks. Left-click the	Registration	Mark	button to place the specific type 
of  registration marks.

plotter Jog
Plotter jog is the ability to position the cutter head by using the Jog	dialog controls in 
EngraveLab. This feature is typically used to reduce wasted material by cutting new shapes 
within unused sections of  media.

Note: For cutters that are connected via a serial port connection, EngraveLab is able to 
query the head position automatically. However, for parallel port connections, you must 
visually confirm the head position.

1. Choose Engrave menu >> Engraving	Defaults.
2. From the Output	dialog, tick the Jog	checkbox.
3. At this point, either use the Shape	Tools flyout to add registration marks, or add 

registration marks in Engrave Preview mode.
4. Choose Engrave menu >> Output.
5. At the far-right of  the Cut	Toolbox, click the Engrave button.
6. The Jog dialog will open, and the tool can be positioned for each registration mark.
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tile settings
If  the design exceeds the limits of  either the machine or material, then the job must be 
divided into tiles that can be output as separate jobs. If  tiles can be repositioned to all fit 
within the available material, then they can be as a single job.

When creating a design, the dimensions of  the loaded material should be considered, and 
one should be mindful of  the maximum physical limits of  the machine. For example, 
consider a roll of  tractor-fed media. Not only is the width of  the media a constraint, but the 
teeth of  the tractor-feed also restricts the width. As a general rule, consult the Operator’s 
Manual to confirm the physical limits of  the machine.

crEatIng tIlEs In EngravE prEvIEw modE
1. Choose Engrave menu >> Output.
2. In the Cut	Toolbox,	click the Tile button.
3. A dashed rectangular bounds will appear around the design.
4. Move the cursor over an edge of  the bounds, such that the cursor becomes a 

bidirectional arrow.
5. Click-and-drag to create a tile line. Both vertical and horizontal tile lines can be created 

in this fashion.
6. After the tile lines have been created, it is possible to select only some of  the tiles for 

printing.
7. For example, tiles can be clicked, such that only tiles with an ‘X’ will be cut.
8. However, if  none of  the tiles have an ‘X’, then ALL of  the tiles will be cut.
9. Click Apply to finish editing the tiles.
10. Drag the tiles to reposition them upon the material.

filter by Color
The Filter	By	Color	option is used to send only one color layer as output to the machine. 
This feature is typically used when cutting shapes from different colors of  vinyl, or where 
tool operations have been assigned colors according to the tool type. If  thick line styles are 
in the design, then the line colors will also be filtered.

Filter By Color can be enabled in the following ways:

A. Choose Engrave menu >> Engraving	Defaults, and then tick the Engrave	by	
Color checkbox. This will cause the Filter	by	Color dialog to automatically open 
in the Engrave	Preview state.

B. Choose Engrave menu >> Engraving	Defaults, and then in the Cut	Toolbox 
click the Filter	by	Color. The Filter	by	Color dialog will open.
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Filter by Color Dialog
Use the Filter by Color dialog (Fig. 85) to choose the color layer that will be output. Once 
the design elements belonging to that color have been output, the dialog will re-open, where 
either the same or another color layer can then be chosen.

output tool usage

Engrave menu >> Output	Tool	Usage

Output	Tool	Usage is an estimation tool that collects statistical information about the 
performance of  the tools being used in cutting or plotting. A variety of  data is gathered 
about each tool, such as the overall distance traveled, the number of  jobs completed, and 
the date of  the last tool change. Using this data, comparisons between successive tools may 
be used to make an informed decision about when tools are likely to decline significantly 
in performance. Tools may then be replaced in advance of  this decline, thereby preventing 
materials from being wasted by an old tool.

EstImatE tImE For currEnt Job
When using this option, be prepared to record the approximate time that is needed to 
complete the next cutting job. After the job is completed, you will be asked to enter the time 
that was expended in completing the job.

Note: From the Help	menu, the TimeSign	feature can be used to record the 
expended time.

Once the expended time has been set, use Engrave menu	>>	Show	Traveled	Distance to 
estimate how much time will be required to cut other jobs. By using this estimate, you can 
better manage your own time, since you will be able to work on other tasks and return when 
the current job is complete.

Fig. 85 - Use the Filter Layer to choose the color that will be 
output, and then click the Select button.

If the Filter Registration Marks option is enabled, then registration 
marks will be cut with all layers.
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Weed and poWer Weed
Weeding is used with cut vinyl applications, where the cut shape must be peeled away from 
its backing. When peeling a vinyl shape, the risk is that it doesn’t pull easily from the backing, 
which can result in unexpected stretching of  the vinyl. This is particularly problematic with 
small text shapes. 

To avoid stretched vinyl, a weed border may be created, which is essentially an extra 
rectangular cut around the shape. Once cutting is done, the rectangular cut can be peeled 
away, followed by the inner shape.

Weed borders can be created in the following ways:

 □ Choose Shape	Tools	flyout >> Weed	Border. This will create a rectangular weed line 
at the indicated offset around the design.

 □ Choose Shape	Tools	flyout >> Power	Weed. Power Weed is like the Weed Border 
tool, except that additional weed lines can be dragged from the edges of  the border. 
Such additional weed lines are typically used to bisect text shapes.

 □ In Engrave	Preview	mode, left-click the Weed	button to create a weed border. The 
offset amount can be set by right-clicking the Weed	button.

Note:	Weed lines will not cut into a given shape.
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Chapter 7

laser engraving

In This Section…
 □ Configuring the workspace for laser engraving designs
 □ Preparing line art and images for laser engraving
 □ Enhancing the quality of  engraved images
 □ Setting preferences within the laser engrave driver

This chapter describes how to configure and output different types of  laser engraving 
output. For line art shapes (i.e., vector shapes), the contour of  such shapes can be output 
as cut lines, and the fill color as a raster fill. In addition, the Photo Laser tool can be used to 
prepare an image for laser engraving.

InstallIng thE prIntEr drIvEr
Like a desktop printer, a laser engraver uses the File menu >> Print command to send 
output. As such, the printer driver that was included with the laser engraver should be 
installed. Typically, the printer driver is on a CD that was shipped with the laser engraver, 
otherwise the manufacturer web site should be checked for the latest driver.

preparing a laser engraving Job
Whereas cutting to a rotary engraver uses the Engrave menu >> Output command for 
sending a job, laser engravers use the File menu >> Print command because the printer 
driver is used to interpret the image data for laser engraving. In this manner, laser engravers 
can interpret object fills and strokes as cut data.

1. Begin by creating a new workspace. The Plate	Size dialog will query for the size of  
your engraving bed.

2. Typically, the Width and Height should be set according to the cutting area of  your 
machine.
These settings can be modified later using Layout menu >> Plate	Size.
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sEt a dEFault color palEttE
1. From the Options menu, choose Palette >> Load >> Set	Default.
 This command is also available through the Shop Palette context menu.

2. The Default	Palette browse dialog will open.
3. From the EngraveLab install directory, browse to the Palettes >> Engrave directory.
4. In the Engrave directory are an assortment of  color palettes per different manufacture 

of  laser engraver. Each palette contains colors used by the given manufacturer to 
indicate speed and power.

5. Choose the color palette that corresponds to your laser engraver, and then click the 
Save button.

6. From the File menu, start a new workspace by choosing New.
7. Along the bottom of  the workspace, note that the Shop Palette has loaded the 

manufacturer palette that you had previously set as the default.

sEttIng FIll and strokE colors
With laser engravers, object fill colors produce an engrave fill, and hairline colors produce a 
cutting line.

1. Under the View menu, confirm that there is a checkmark beside the Show	Fill option.
2. Under the View menu, confirm that there is a checkmark beside the Show	Tool	Paths 

option.

3. Create a circle shape and assign a black fill.
 (i.e., select the circle and left-click black in the Shop Palette)

4. Draw a square around the circle and assign an Invisible fill (Fig. 86).
 (i.e., select the square and left-click Invisible in the Shop Palette)

5. Select the square shape.
6. From the Stroke	and	Fill	Tools flyout, choose Tool	Diameter.
7. In the SmartBar, choose a Hairline style, and set a red stroke color (Fig. 87).
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Fig. 86 - Assign an invisible fill to the square.

Fig. 87 - Within the laser engraver’s printer driver, the red color represents a specific 
power and speed setting.
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prIntIng to thE lasEr EngravEr
As mentioned previously, laser engraving output is driven through a printer driver, so output 
from EngraveLab is done using the File menu >> Print command.

1. Choose File menu >> Print to open the Print dialog (Fig. 88).
2. On the Printer tab, select your laser engraver.

Note:	If  your laser engraver is not listed, then refer to the installation instructions provided 
with your laser engraver.

3. Tick the Preview checkbox.

4. Click the Preferences tab (Fig. 89).
5. Tick the Print	As	Shown	On	Screen checkbox.
6. Click the Plate	Area option.
7. If  required, tick the Print	by	Colors option, which is used to maintain a particular 

sequence in which the objects are cut.
8. On the Printer tab, click the Setup button.
9. The Properties dialog for your laser engraver will open.

Fig. 88 - The driver for the laser engraver will appear in 
the Print dialog like that of a printer driver.
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10. The controls on the Properties dialog will vary according to your model of  laser 
engraver (Fig. 90). For specific instructions concerning these controls, please refer to 
the documentation provided with your laser engraver.

11. The following aspects of  the Properties dialog should be checked:
 □ For the colors defined within the driver, adjust the power and speed settings as 

required.
 □ For each color, set the pen mode to output both raster and vector data.
 □ Confirm that the engraving area is correct.
 □ Set the cutting mode to Black and White.

Fig. 89 - The Photo Laser dialog provides specialized 
filters that are used to prepare an image for optimal laser 
engraving output.
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12. Click OK to accept the Print dialog settings and enter the Print	Preview page.

sEndIng thE lasEr EngravIng Job
1. The file is ready to be output.
2. Confirm that the machine is online and loaded with the appropriate material.
3. In Print	Preview, click Print to begin engraving.

Fig. 90 - The Properties dialog controls will vary according to the 
model of laser engraver.
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preparing an image for laser engraving
The Photo Laser tool is used to prepare an image for output through a laser engraver. Various 
image filters are available for improving the quality of  the image, and you can choose from 
preset settings that have been configured for different types of  material. Since a laser engraver 
is essentially a monochrome device (laser on, or laser off), any color information retained in the 
image is not useful, so the resulting photo laser image will be in monochrome format.

1. Import an image onto the workspace.
2. From the Transform menu, choose Photo	Laser >> Interactive.
3. The Photo	Laser dialog (Fig. 91) will preview the effect of  applying the various filters.
4. In the Filter list, right-click will toggle a filter between ON/OFF.

suggEstIons For adJustIng FIltErs From scratch

Note: In the lower-left corner of  the Photo	Laser dialog, click the Load	Presets button 
to choose from an assortment of  parameter files that have been configured for various 
materials.

If  you wish to adjust the Photo Laser settings without using preset values, then it is recommended 
that you start with only one filter, and then incrementally increase the number of  filters until you 
achieve the desired results. For example:

 □ Right-click to turn OFF all the filters, except for the Histogram filter.
 □ Adjust the Histogram filter to trim excess shadow (Black) and excess highlight (White).
 □ If  necessary, adjust the midtone (Gamma) to obtain more balance in the resulting shades.
 □ At this point, the image can be further refined by incrementally turning on more filters, one 

by one, and making adjustments as appropriate.
 □ For example, turn ON an Edge filter, set it to Unsharp	Mask, and then adjust the 

Amount, Radius and Threshold to find values that produce good results.
 □ Then turn ON the Threshold filter and adjust the Threshold slider to help sharpen the 

image.

Fig. 91 - The Photo Laser dialog provides specialized filters that are used to prepare an 
image for optimal laser engraving output.
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Chapter 8

drafts and proofs

In This Section…
 □ Printing to a Windows printer
 □ Adding rough notes to your EngraveLab design
 □ Collecting notes about the customer and design
 □ Creating a layout template for your customer proofs
 □ Sending previews to customer via e-mail

WindoWs printer driver
The File	>> Print	command is used to print to a desktop printer. For a printer to be available, its 
printer driver (provided by the manufacturer) must be installed in the Windows Control	Panel.

Using the Print	dialog relies upon Microsoft’s color management and the printer driver 
to control the print layout, quality, and color integrity of  the printed image. Though this 
method is common to all Windows applications, it is not recommended for printing large 
signage.

preferenCes When printing a draft
Choose File menu >> Print to open the Print dialog. The Print dialog settings are used to 
preview the draft and choose draft options.

 □ On the Printer	tab, enable the Preview	option. When the OK	button is clicked, the 
print job will be previewed, which will allow you to position and scale the draft.

 □ On the Preferences tab, tick the Dimensions	and	Notes option. This will allow any 
dimensions or notes to be printed.

 □ If  it is helpful, then enable the Guidelines	or Grid	Lines	options.
 □ To avoid printing weed borders in the draft, enable the Do	Not	Print	Weed	Border	

option.
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dimensions and notes
On the EngraveLab workspace, dimensions and notes are created from the Measure	
Tools flyout. When dimensions are scaled, the measurement will be updated automatically. 
Similarly, if  dimensions are grouped with shapes, then scaling the group will update the 
measurement automatically.

	□ Dimension – Measure the distance between two points.
	□ Object	Dimension – Measure the height or width of  the selected object.
	□ Arrow	Draw – Annotate the workspace. For each arrow drawn, a note may be created. 

Double-click the arrow to edit its thickness.
	□ Notes – Add descriptive notes to the workspace.

Job/Cost notes
The Job/Cost	Notes are used to include additional information about the customer, and 
construction details for the design. When a draft is printed, the Job/Cost Notes should be 
printed as well to serve as a reference.

For future jobs, customer contact information can be reused. In the Job	Notes	Summary	
dialog, the company name can be selected from the drop-list.

Creating a draft template
When a EngraveLab workspace is saved, its file type is a CADlink Drawing File (CDL). A 
“template file” is like a regular CDL file, except that it also includes variable fields. When the 
template file is opened, the variable fields are either completed automatically (such as date 
fields), or EngraveLab will prompt you for the text (such as customer name).
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tools whEn workIng wIth tEmplatE FIlEs:
	□ File	>>	Open – Load a template file. Variable fields like Time and Date will be 

automatically updated. For other fields like File and Text, you will be prompted to 
complete the field.

	□ File	>>	Edit	Template… – Load a template file without completing the text fields.
	□ Layout	>>	Templates	>>	Set	Template – Use the Text	Compose tool to create a 

text shape. The text can then be selected and converted into a variable field of  type: 
File, Date, Time, or Text.

	□ File	>>	Save – Save the template file with variable fields.
	□ File	>>	Save	as… – After loading a template file and completing the variable fields, 

save the file under a new name.

After using File	>>	Open to load a template file, make sure that the file is saved under a new 
name. Otherwise, you will overwrite the original template file.

ExamplE oF crEatIng varIablE tExt
1. Use the Text	Compose tool to create a text shape “Customer Name”.
2. Select the text shape, and then choose Layout	>>	Templates	>>	Set	Template	>>	

Text.
3. Use File	>>	Save	as… to save the template file.
4. Close the file and start a new EngraveLab workspace.
5. Use File	>>	Open to open the template file.
6. Note that you are prompted to enter text for “Customer Name”.
7. After the template has been loaded, use File	>>	Save	as… to save the file under a new 

name.

load an ExamplE tEmplatE FIlE
1. Use the File	>>	Open command to load “portrait.cdl” from the CADlink \ 

EngraveLab \ Template directory.
2. You will be prompted to enter text for: File Name, Designer, Contact, and Customer.
3. You will then be prompted to import a previously saved image file.
4. Press [F8] to see the complete design, which can be used as a proof  for sending to 

customers.
5. Note that the date has been updated automatically.
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send image by e-mail
Use the Send	Image	by	E-mail	command to send a preview of  the current EngraveLab 
design via e-mail.

 □ Instead of  including the entire design, it is possible for only selected objects to be 
previewed.

 □ Your company logo can be included with the preview, and clicking the logo can help the 
customer to locate your web site.

 □ Optionally, job notes can be included with the preview (see File	menu >> Job/Cost	
Notes).

 □ When the Send	button is clicked, the preview will be opened in your default e-mail 
client.

ExamplE - sEndIng a pdF prooF
Use the following steps when configuring the Send	Image	by	E-mail command to send a 
PDF proof  to a customer:

1. Make note of  the customer e-mail address, so that it is handy later.
2. Go Web menu >> Send	Image	by	E-Mail.
3. The E-mail	Preview dialog will open.
4. Click Settings to open the E-mail	Preview	Settings dialog.
5. Click Advanced to open the Advanced	E-mail	Preview	Settings dialog.
6. From the Image	format drop-list, choose PDF.
7. Click OK, and then click OK again.
8. From the E-mail	Preview dialog, click Send.
9. The PDF	Settings dialog will open.
10. Set the Quality = Low.
 Choosing medium or high quality can create a file size that is excessive for e-mail. 

Generally, seek a file size that does not exceed 5MB, though preferably less than 1MB.

11. Click OK to proceed.
12. Per your e-mail client, an e-mail editing window will be populated with the job details, 

and the PDF will be added as an attachment.
13. Enter the e-mail address of  the customer, and type a descriptive subject line.
14. The message is now ready for sending.

Note: In older versions of  Microsoft Outlook (2000 and 2003), there is a bug that can 
prevent the Send button from working. In such a case, use the [ALT	+	s] shortcut to send 
the message.
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ExamplE - sEndIng a png or JpEg prooF
Use the following steps when configuring the Send	Image	by	E-mail command to send a 
PNG or JPEG proof  to a customer:

1. Make note of  the customer e-mail address, so that it is handy later.
2. Go Web menu >> Send	Image	by	E-Mail.
3. The E-mail	Preview dialog will open.
4. Click Settings to open the E-mail	Preview	Settings dialog.
5. Set the Preview	image size slider according to the approximate image size that the 

customer should be provided with.
 Generally, a pixel width from 400 pixels to 800 pixels will provide enough detail without 

exceeding a convenient viewing area of  a computer monitor.

6. Click Advanced to open the Advanced	E-mail	Preview	Settings dialog.
7. From the Image	format drop-list, choose either PNG or JPG (i.e., JPEG).
8. Click OK, and then click OK again.
9. From the E-mail	Preview dialog, click Send.
10. Per your e-mail client, an e-mail editing window will be populated with the job details, 

and the PNG or JPG file will be added as an attachment.
11. Enter the e-mail address of  the customer, and type a descriptive subject line.
12. The message is now ready for sending.

Note: In older versions of  Microsoft Outlook (2000 and 2003), there is a bug that can 
prevent the Send button from working. In such a case, use the [ALT	+	s] shortcut to send 
the message.
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appendix a

hot keys and shortCuts

In This Section…
 □ Keyboard menu shortcuts
 □ Function keys
 □ Hot keys for aligning shapes
 □ Using guidelines for layout
 □ Node palette and node editing hot keys
 □ The grid and align palette
 □ Color palette tips, and color substitutions
 □ Selecting and manipulating shapes

keyboard menu shortCuts
Please note that the EngraveLab menus have keyboard shortcuts (not listed here) that will 
reduce your editing time. These shortcuts are listed next to each menu item, and these 
shortcuts can be customized (added, changed, deleted) by choosing Customize	Shortcuts	
under the Options	menu.

funCtion keys
The function keys in EngraveLab operate as follows: 

[F1] Help
[F2] Disable all Shop Palette color layers 

except the current target layer
[F3] Select all objects
[F4] Refresh the workspace
[F5] Zoom marquee
[F6] Zoom out

[Shift+F6] Zoom in
[F7] Zoom to selected object
[F8] Zoom to Plate Size
[F9] Toggle between current and previous 

zoom levels
[F10] Select the menu bar
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align seleCted shapes
To align selected shapes quickly, use the following hot keys:

[ALT	+	1] Align shapes along left edge of  bounds
[ALT	+	2] Center shapes vertically
[ALT	+	3] Align shapes along right edge of  bounds
[ALT	+	4] Align shapes along top edge of  bounds
[ALT	+	5] Center shapes horizontally
[ALT	+	6] Align shapes along bottom edge of  bounds
[ALT	+	7] Center shapes both horizontally and vertically

align shapes to the plate size
To align shapes to the plate size, use the following hot keys. Most of  these correspond to Layout	
menu >> Arrange	and	Distribute	>> Align	to	Plate.

[ALT	+	Delete] Left	– Align with left edge of  plate
[ALT	+	Page	Down] Right – Align with right edge of  plate
[ALT	+	Insert] Top – Align with top edge of  plate
[ALT	+	Page	Up] Bottom	– Align with bottom of  plate
<no	default> Center – Align with center of  the plate.
[ALT	+	End] Center	Horizontally	– Center horizontally 

along height of  plate
[ALT	+	Home] Center	Vertically – Center vertically along width 

of  plate
[Ctrl	+	Q] Equal	Spacing	– Space text objects equally over 

height and width of  plate.
<no	default> Equal	Vertical	Spacing	– Space text objects 

vertically across plate.
<no	default> Equal	Horizontal	Spacing	– Space text objects 

horizontally across plate.
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align shapes to last seleCted obJeCt
When using [Shift] to select a collection of  objects, the following hot keys will align shapes to 
most recently selected object”

[L] Left – Align with the left edge of  the last object.

[R] Right – Align with the right edge of  the last object.

[T] Top – Align with the top edge of  the last object.

[B] Bottom – Align with the bottom edge of  the last object.

[E] Horizontally – Center horizontally along height of  last object.

[C] Vertically – Center vertically along width of  last object.

guidelines
When dragging shapes, guidelines are used for precise alignment. A shape will “snap” to the 
location when dragged near a guideline.

Opening the Edit Guides Dialog
 □ When there is no selection, right-clicking on the workspace will open the Edit	Guides 

dialog.
 □ Under the Options menu, choosing Guides >> Edit	Guides will open the Edit	
Guides dialog.

 □ Double-click a guide for editing within the Edit	Guides dialog.

Creating a Guide
 □ Use the Edit	Guides dialog.
 □ Right-clicking a ruler will create a guide.
 □ For a selected shape, press [Shift] and right-click the shape nubs to create guides (not 

when editing a parametric shape).
 □ To add guides when node editing, press [Shift] and right-click the node.

Moving, Locking, and Hiding Guides
 □ When dragging a guide, press [Shift] to constrain the guide to the nearest ruler 

increments.
 □ To lock guides in place, right-click the workspace to open the Edit	Guides dialog and 

check Lock	Guides.
 □ To temporarily hide the guides, choose Options menu >> Guides >> Use	Guides. 

The default shortcut to toggle guides On/Off  is [Alt	+	W].
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 □ To remove a guide, press [Shift] and right-click the guide (when there are no objects 
selected).

Guide Labels
 □ To edit font labels, open the Edit	Guides dialog, click either the horizontal or vertical 

guide button, then click the Label	Font button.

node editing
When node editing a polygon or polyarc object, clicking the fill region of  another object will 
switch node editing to the other shape. When node editing an object that overlaps another 
object, hold the [ALT] key to prevent the accidental selection of  the underlying object.

thE nodE palEttE
When editing a polygon or polyarc object, pressing the right-mouse button will access the 
Node	Palette, which provides commonly used tools for changing node type, joining and 
breaking nodes, and setting the start point and direction for routers and engravers.

Please note that since polyarc objects are composed only of  curve nodes, the Node	Palette 
will not allow you to change the node type for polyarcs (Fig. 92).

Fig. 92 - The Node Palette as it appears for polygon 
shapes (left), and polyarc shapes (right). Polygons 

can have Corner, Curve and Tangent nodes, whereas 
polyarcs use only Curve nodes
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thE alIgn palEttE
The Align	Palette (Fig. 93) provides a quick means of  snapping a selected node to the 
nearest grid line or intersection. In addition:

	□ Set	Origin will set the grid origin according to the selected node.
	□ Resize	Grid will resize the grid increments based on the distance between the selected 

node and the origin.
 □ If  necessary, the origin can be reset via Options menu >> Reset	Origin.
 □ The Grid	Size can also be set from the General	Preferences dialog.

Fig. 93 - Select a node, and then use [Ctrl + right-click] to access the Align Palette.
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polygon EdItIng hot kEys
In addition to the Node	Palette, the following keyboard hot keys are available when editing 
polygon objects:

	□ (A)	Add	node	– Create node at current cursor location.
	□ (C)	Change	node	– Cycle type of  selected node. Type will cycle through Corner, 

Curve, and Tangent.
	□ (R)	Remove	– Delete the selected node.
	□ (L)	Locate	origin	– Set grid origin to selected node.
	□ (G)	Grid	dimensions	– Set the grid size as the distance between the selected node and 

the grid origin.
	□ (S)	Snap	to	intersection	– Move selected node to the nearest grid intersection.
	□ (H)	Snap	to	horizontal	grid	line	– Move node to the nearest horizontal grid line.
	□ (V)	Snap	to	vertical	grid	line	– Move node to the nearest vertical grid line.
	□ (J)	Join	– Join two nodes with a connecting line.
	□ (B)	Break	– Break contour at selected node.
	□ [F3]	– Select all nodes.
	□ [ALT	+	F3]	– Inverse selects all nodes.
	□ (U)	Alternate	Select	– Select every other node of  currently selected nodes.
	□ (D)	Deselect	– Clear the current node selection.
	□ (O)	Create	perfect	circle	– Form nodes into a perfect circle.
	□ (T)	Toggle	start	point	– Set the start point for routing or engraving this object.
	□ (K)	Click	– Select the node under the mouse cursor.
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polyarc EdItIng hot kEys
In addition to the Node	Palette, the following keyboard hot keys are available when editing 
polygon objects:

	□ (A)	Add	node	– Create node at current cursor location.
	□ (R)	Remove	– Delete selected node.
	□ (L)	Locate	origin	– Set grid origin to selected node.
	□ (G)	Grid	dimensions	– Set the grid size as the distance between the selected node and 

the grid origin.
	□ (S)	Snap	to	intersection	– Move selected node to nearest grid intersection.
	□ (H)	Snap	to	horizontal	grid	line	– Move selected node to nearest horizontal grid line.
	□ (V)	Snap	to	vertical	grid	line	– Move selected node to nearest vertical grid line.
	□ (J)	Join	– Join two nodes with a connecting line.
	□ (B)	Break	– Break contour at selected node.
	□ [F3]	– Select all nodes.
	□ [ALT	+	F3]	– Inverse selects all nodes.
	□ (U)	Alternate	Select	– Select every other node of  currently selected nodes.
	□ (T)	Toggle	start	point	– Set start point for routing or engraving this object.
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Color palette tips
When clicking a color in the Shop or Job Palettes, additional tools are activated by pressing 
the [Shift], [Control], or [ALT] keys. The following table summarizes these modifiers:

	□ Left-click	– Set fill color of  current object
	□ Right-click	– Set line style color of  current object
	□ [Shift]	+	Left-click	– Select all objects of  that fill color
	□ [Control]	+	Left-click	– Disable the color plate. All objects with that fill color will 

appear as dashed outlines.
	□ [ALT]	+	Left-click	– Disable all color plates, except for the plate that was clicked

You can also use these modifiers with the Sheet	Layer and Halftone	Palettes.

Job palEttE substItutIons
In addition to listing colors, the Job	Palette can be used to perform global search-and-
replace of  colors, primers, halftones, etc.

Set all red shapes to a blue fill color
1. Suppose that you have several red shapes
2. In the Job Palette, click the ellipsis button and choose Color	View from the context 

menu
3. Note that the red color appears in the Job Palette
4. From the Shop Palette, drag a blue color plate and drop it onto the red Job Palette color

Replace all shades of a spot color
1. Suppose that you have five shapes with different tints of  a gold spot color, say 100%, 

80%, 60%, 40%, and 20% tint
2. In the Job Palette, click the ellipsis button and choose Foil	View from the context 

menu
3. Note that the Job Palette lists the different shades of  gold as a single color plate
4. From the Shop Palette, drag a green spot color and drop it onto the gold Job Palette 

color

seleCting and manipulating shapes
To select a shape, click within the fill area of  the shape. If  Show	Fills is off  (under the View	
menu), then select the shape by clicking along its contour.

If  the [ALT] key is used as a modifier key, then the shape will only become selected by 
clicking along its contour. This is a useful means of  differentiating from between several 
clustered shapes.
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swEEp sElEctIng obJEcts
A sweep select is simply a quick means of  selecting several objects by surrounding the 
objects with a marquee. Modifier keys may also be used as follows:

Shift-sweep Select
 □ Add the objects to the current selection.

Control-sweep Select
 □ All objects that fall within bounds of  the marquee will become selected. The current 

editing operation (if  any) will be applied to the objects.

Alt-sweep Select
 □ For small objects that are within the area of  a larger object, use [ALT] + marquee to 

select the small objects without selecting the larger object.
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appendix b

feature loCator

In This Section…
 □ Workspace Settings and Customizations
 □ Line Art and Vector Shapes
 □ Text Editing
 □ Importing and Exporting File Types
 □ Color Palettes
 □ Image Creation and Editing
 □ Design Layout and Editing
 □ Printing
 □ Engraving

This appendix shows how to locate specific features in EngraveLab. To use this list, locate 
the EngraveLab feature name that you want (listed in alphabetical order), and then use the 
sequence that is given with that feature. For example, features for customizing the grid 
would be listed as follows:

Grid Lines (change between lines and dots)
Options menu  Grid  Show Grid as Lines

Grid Size
Options menu  EngraveLab Setup  General Preferences  Grid Size
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workspacE customIzatIons

Keyboard shortcuts
Options  Customize Shortcuts

Warning dialog reset
Options  EngraveLab Setup  General Preferences  Reset 

multIplE EngravElab wIndows

Enable multiple windows
Options  Multiple Instance

Multiple windows – Close
File  Close

Multiple windows – Close All
File  Close All

platE sIzE

Plate size
Layout  Plate Size

Plate Size outline On/Off
View  Show Plate

Snap to plate size
Options  Snap to Plate

Create plate shape
Layout  Plate Object
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lInE art and vEctor shapEs

Basic Shape Creation
Tools toolbar  Shape Tools 

Clip art shapes
Layout  Clip Art Viewer

Convert to polyarc / polygon
Arrange  Convert To  Polyarc / Polygon

Combine Shapes
Arrange  Make Path

Sketch Line Art
Tools toolbar  Graphics Edit Tools  Node / Free / Arc Edit

Stretch
Arrange  Stretch

Weed border object
Tools toolbar  Shape Tools  Weed border

Weld tools
Tools toolbar  Weld Tools

shapE FIlls

Fill colors On/Off
View  Show Fill

Fill Color
[Left-click] a Shop Palette color

Gradient fill color
Tools toolbar  Stroke and Fill Tools  Gradient Fill

Blend colors between two shapes
Transform  Metamorphosis

Pattern fills using an existing bitmap pattern
Tools toolbar  Stroke and Fill Tools  Pattern Fills
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strokE wIdth and tool dIamEtEr

Highlight selected objects
Options  EngraveLab Setup  Selection Tool Settings  Highlight selected objects

Show tool paths
View  Show Tool Paths

Show width of tool paths
View  Show Tool Diameter

Hairline shown for line art
View  Show Fill

Add stroke
Tools toolbar  Stroke and Fill Tools  Tool Diameter

Stroke color
[Right- click] a Shop Palette color

color palEttEs

Shop Palette
View menu  Palettes  Show Shop Palette

Edit Color
<Double-click a Shop Palette color >

Create Custom Color
Shop Palette context menu  Custom Color Creator

Manufacturer Palette
Shop Palette context menu  Open Manufacturer Palette
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tExt EdItIng

Install Font
File  Install  Fonts

Create text
Tools Toolbar  Text Tools  Text Compose

Text To Graphics
Arrange  Text To Graphics

Fit Text To Arc
Transform  Fit Text To Arc

Kern a selected text shape
Tools Toolbar  Text Tools  Text On-Screen Kerning

Meld script letters into single shape
Tools toolbar  Weld Tools  Basic Weld

Remove slanted text
Edit Text  [Left-click] Font Slant Degree button

spEll chEck

Spell check all text shapes
Tools Toolbar  Text Tools  Spell Check

Spell check current text shape
Edit Text  Spell Check
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ImagEs and bItmaps

Convert line art to bitmap
Transform  Render To Bitmap

Change Bitmap Color Mode
Image  Mode

Clip Bitmap to Line Art
Position shape over bitmap  Select both objects  Arrange menu  Clipping

Crop Background of Bitmap
Image  Fluid Mask (if Fluid Mask has been purchased)

Color Adjustments
Image  Color Adjustments (e.g., Levels, Brightness, etc.)

Image editing
Tools toolbar  Scan Tools  AccuScan 

Image menu filters
Image  Filters (e.g., Blur, Sharpen, Noise, Stylize)

Image Size and Resolution
Image  Image Size

Posterize image
Tools toolbar  Scan Tools  AccuScan  Posterize Region

Trace image into line art
Tools toolbar  Scan Tools  AccuScan  Trace

plug-Ins

Plug-in activation
Image menu  Options  Plugin Paths
<Plug-ins appear under Image menu after their install location has been specified.>

Plug-in foreground and background color (used by select plug-ins)
Image  Options  Set Foreground Color

Plug-in install locations
Image  Options  Plugin Paths
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clIppIng paths

Clipping path
Arrange  Clipping  Clipping

Clipping path clear
Arrange  Clipping Clear

ImportIng, ExportIng, lInk to FIlE

Export Images
File  Export (e.g., AI, EPS, etc.)

Export Line Art and/or Images
File  Export Image (e.g., BMP, JPEG, TIFF, etc.)

Export to PDF
File  Publish to PDF

Import a CDL file into current workspace
File  Import

Linked Images - Save all linked images within CDL file
File  Save Embedded File

dEsktop scannErs

Scan an image
File  Acquire Image  Acquire

Scan an image as line art
File  Acquire Image  Acquire Vector

Scanner – Choose scanner
File  Acquire Image  Select Source
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layout

Alignment
Layout  Arrange and Distribute  Alignment

Badges
Layout  Badges

Group
Layout  Group

Group Viewer
[Double-click] a group of objects

InstantReplay
Options  Use InstantReplay

Move shape above all other shapes
Arrange  Order  [To Front, To Back, Forward, Backward]

Move shapes above/below each other

Layout  Sequence  Sequence By List 

Nesting
Arrange  Block Nesting

Template file editing
File  Edit Template

Template text fields
Layout  Templates

grId sEttIngs

Grid – Objects snap to grid On/Off
Options  Grid  Snap to Grid

Grid origin position
Layout  Plate Size  Origin Selection

Grid origin reset
Options  Reset Grid
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Grid visible On/Off
View  Show Grid

Grid width and height
Options  EngraveLab Setup  General Preferences  Grid Size

Snap to grid
Options  Grid  Snap to Grid

guIdElInEs

Guides creation 1
[Right-click] a ruler

Guides creation 2
[Shift] + [Right-click] an object handle

Guides deletion – all guides
Options  Guides  Remove All Guides

Guides deletion – one guide
[Shift] + [Right-click] an existing guide (no objects selected)

Guides editing 1
Options  Guides  Edit Guides

Guides editing 2
[Right-click] an existing guide (no objects selected)

Guides locking
Options  Guides  Edit Guides  Lock Guides

Guides visible On/Off
Options  Guides  Use Guides

Snap to guides
<Automatic for visible guides>
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rotary EngravIng

Contour cut objects
Engrave  Contour Cut

Add tool paths
Engrave  Create Tool Path

Tools toolbar  Tool Path Tools

Engrave preview mode
Engrave  Output

Output a rotary engraving job
Engrave  Output  Cut Toolbox toolbar  Engrave

Rotary Machine Configuration
Engrave  Engraving Defaults

Machine limits
Engrave  Engraving Defaults  Setup  Engraver tab  Machine Limits

Machine origin
Engrave  Engraving Defaults  Setup  Engraver tab  Options

Feeds and speeds
Engrave  Tool Options

Origin Jog
Engrave  Engraving Defaults  Origin Jog

Port setting for machine
Engrave  Engraving Defaults  Setup  Port tab

lasEr EngravIng

Laser Engraver Configuration
File  Print  Setup

Output a laser engraving job
File  Print

Prepare image for laser engraving
Transform  Photo Laser
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Symbols

3D Chisel Tool Path  131

A

AccuScan  120
AccuScan and Image menu filters  121
Acquire  100
Acquire Image  99
Acquire Vector  100
Alien Skin Plug-ins  117
Alignment  90
Alignment Hot Keys  88
Align Palette  88, 155
Align To Baseline  100
Array  91
Arrow Draw  146

B

Badges  94
Badges (multiple)  60
Badges (single)  54
Badge Text Substitution  95
Balance Colors  110
Baseline alignment  100
Basic Weld  75
Bevel Bitmap Effects  104
Bitmap Creation  104
Bitmap Editing (AccuScan)  120
Bitmap Palette Colors  121
Bitmap Transformations  83
Blends using Metamorphosis  79
Block Shadow  84
Blur Filters  110

Noisy Blur  116

C

CADlink Plug-ins  119

Cast Shadow  84
Chisel Bitmap Effects  104
Clear Color  78
Clearing an Image Background  106
Clear Size/Move  77
Clip-Art  99
ClipArt

Decorative Borders  85
Clipping and Clipping Clear  82
Clipping an Image Background  106
CMYK  78, 104
Color Adjustments  109
Color Blends  78
Color Palettes  72
Color Palette Tips  72, 158
Color Types  78
Compress Equally Over Copies  94
Contour Cut Paths  47
Contrast/Brightness  109
Converting bitmaps into line art  122
Convert to Curves  100
Copyright Notice  11
Curves Dialog  109
Customizing Keyboard Shortcuts  151
Customizing the Workspace  28
Cut Paths for Images  49

D

Decorative Border  85
Decorative Border Clip-Art  85
Digitizing Tablets  101
Dimensions  146
Dongle  26
Draft CDL Templates  146
Drafts and Proofs  145
Drill Center  132
Drill Contour  131
Drill Point  131

index
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Drop Shadow  84

E

Easy Color Adjustments  109
Engrave Preview  132
Exporting Files  98

F

Feeds and Speeds  128
Female Tool Path  130
Fill Colors  77
Fill Tool Path  131
Filter By Color  134
Filters  110
Fit Text to Arc  75
Fit Text to Path  75
Flip  77
Fluid Mask  106
Foil Colors  78
Function Keys  151

G

Ginsu Knife  74, 82
Gradient Fill  78
Graphic Edit Tools  73
Grid lines  88
Groups of  shapes  81
Group Viewer  81
Guidelines  87, 153

H

Halftone Filter  111
Harry’s Filters (Plug-ins)  114
Histo Contrast  110
Histo Equalize  110
Hue/Saturation  109

I

Image Background (Deleting)  106
Image Cut  125

Image Editing (AccuScan)  120
Image Menu

Color Adjustments  109
Filters  110
Plug-In Filters  112

Image Size  105
Image Transformations  83
Image Type (Mode)  104
Importing Files  31, 97
Inline  82
Installation  27
InstantReplay  28, 77
Invert  109
Invisible Color  78
Invisible Color Blend  79
Iron filings  125

J

Job/Cost Notes  146
Job Palette  72
Job Palette Substitutions  158

K

Keyboard Shortcuts  151
KnockMeBlackOut  119
KnockMeColorOut  119

L

LAB  78
Laser Engraving  137
Laser Engraving Setup Procedure  39
Lasso Selection  76
Levels Tool  109
Line/Fill Button  77
Line Style  77

Show Tool Diameter  71

M

Male Tool Path  130
Merge Colors  122
Metamorphosis  79, 83
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Mirror  77
Miter Limit  82
Monochrome Filter  51
Move  77
Multiple Instance  29

N

Nesting  92
Node Editing  154
Node Edit Tools  73
Node Palette  154
Noise Filters  111, 116
Notes  146
Nubs  76
Nudge  77

O

Object Dimensions  146
Online Tool Path  129
Order To Front  81
Outline  82
Output Tool Paths  125
Output Tool Usage  135

P

Pattern Fill  78
Perspective Shadow  84
Photo Laser Engraving  66, 143
PhotoMachine  125
Plate Design (series, multiple per plate)  

60
Plate Design (series, single plate)  54
Plate Design (single)  52
Plate Size  30, 71
Plotter Jog  133
Plug-In Filters  112

Alien Skin Sampler  117
CADlink Collection  119
Filter Forge  117
Harry’s Filter Collection  114
Mehdi  119

Redfield Collection  113
Richard Rosenman Collection  113

Posterize
Color Adjustments  109
Posterize Filter  119
Posterize Region (AccuScan)  122

Power Weed  136
Prepare to Vectorize Wizard  123
Previewing a Cut-Only Job  132
Process Color  78

R

Rain  125
Redfield Plug-ins  113
Registration Marks  133
Relief  Shadow  84
Remove Red Eye  111
Render Contour Bitmap  104
Rendering Bitmaps  104
Replacement Data File  95
Reset Origin  88
Resizing Images  105
Richard Rosenman Plug-ins  113
Rotary Engraving  127
Rotary Engraving Setup Procedure  32
Rotate  77
Round Corners  85
Rulers  29

S

Scan and Trace Wizard  100
Scanning Artwork  99
Scratch Disk  103
Selecting and Manipulating Shapes  158
Selecting Shapes  76
Select Source  99
Send Image by E-mail  148
Sequence  91
Serializing Badge Data  95
Shadow  84
Shape Creation  73
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Sharpen Filters  110
Sheet Layer Palette  72
Shop Palette  72
Show Traveled Distance  135
Size  77
Slant  77
SmartBar  72
Snap Angle  76
Spell Check  75
Spot Color  78
Spot Foil  78
Squares  125
Stars  125
Start Sequence  91
Stencils  86
Stretch Intensity  110
Stroke Color  77
Strokes  77

Show Line Style  71
Stylize / Artistic filters  111
Super Size Image  105
Swap Colors  110
Sweep Selecting Objects  159

T

Template CDL Files  146
Text Creation  74
Text to Graphics  82
Text Underline  75
Threshold Value  51
Tile Settings (Cut-Only)  134
Tool Options  128
Tool Paths  129
Tools Toolbar  72
Tool Tracking  135
Tracing Artwork into Cut Paths  44
Tracing Images

Classic Vectorization Method  122
Prepare to Vectorize Wizard  123

Transformation  83

Transparency
Transparency Fill  78
Transparency Opacity plug-in  119

Transparent Bitmap Color  104, 121

U

Undo Setup  103
Ungroup  81
Unsharp Mask  110

V

Vectorization of  Images
Classic Vectorization Method  122
Prepare to Vectorize Wizard  123

W

Weed Borders  136
Weld Tools  81
Wiggle  125
Windows Printer Driver  145
Workspace Settings  71


